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1  Welcome to the GBAS option
The R&S SMW-K111 is a firmware application that adds functionality to generate sig-
nals in accordance with the Ground-Based Augmentation System (GBAS) standard.

This user manual contains a description of the functionality that the application pro-
vides, including remote control operation.

All functions not discussed in this manual are the same as in the base unit and are
described in the R&S SMW user manual. The latest version is available at:

www.rohde-schwarz.com/manual/SMW200A

Installation

You can find detailed installation instructions in the delivery of the option or in the
R&S SMW service manual.

1.1  Key features

The R&S SMW-K111 features

● Generation of the VHF Data Broadcast (VDB) Signal-in-Space signal transmitted
from the GBAS ground subsystem to the airborne subsystem

● User-definable transmission band and support of single and multi-frequency trans-
mission (up to 11 frequency channels simultaneously), for example for adjacent
channel emissions measurements

● Support of GBAS mode:
– Configuration of local area augmentation system (LAAS) message blocks
– Configuration of GBAS application data, for example the parameters of mes-

sage type 2 and 4, incl. the Final Approach Segment (FAS) data definition and
Terminal Area Path (TAP) data

– Import of differential global navigation satellite system (DGNSS) data (message
type 1 and 11)

– Encoding, timing and power settings according to the specification RTCA
DO-246D

● Support of SCAT-I mode:
– Configuration of special category (SCAT-I) message blocks
– Configuration of GBAS application data, for example the parameters of mes-

sage type 4, incl. the Final Approach Segment (FAS) data definition data
– Import of differential global navigation satellite system (DGNSS) data (message

type 1 and 11)
– Encoding, timing and power settings according to the specification RTCA

DO-217

Key features

https://www.rohde-schwarz.com/manual/smw200a
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1.2  Accessing the GBAS dialog

To open the dialog with GBAS settings

► In the block diagram of the R&S SMW, select "Baseband > GBAS".

A dialog box opens that displays the provided general settings.

The signal generation is not started immediately. To start signal generation with the
default settings, select "State > On".

1.3  What's new

This manual describes firmware version FW 5.30.047.xx and later of the
R&S®SMW200A.

Compared to the previous version, it provides the new features listed below:
● Time-based triggering, see "Time Based Trigger" on page 57 and "Trigger Time"

on page 58.
● Editorial changes

1.4  Documentation overview

This section provides an overview of the R&S SMW user documentation. Unless speci-
fied otherwise, you find the documents at:

www.rohde-schwarz.com/manual/smw200a

1.4.1  Getting started manual

Introduces the R&S SMW and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc. A printed version is delivered with the instrument.

1.4.2  User manuals and help

Separate manuals for the base unit and the software options are provided for down-
load:
● Base unit manual

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

Documentation overview

http://www.rohde-schwarz.com/manual/smw200a
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● Software option manual
Contains the description of the specific functions of an option. Basic information on
operating the R&S SMW is not included.

The contents of the user manuals are available as help in the R&S SMW. The help
offers quick, context-sensitive access to the complete information for the base unit and
the software options.

All user manuals are also available for download or for immediate display on the Inter-
net.

1.4.3  Tutorials

The R&S SMW provides interactive examples and demonstrations on operating the
instrument in form of tutorials. A set of tutorials is available directly on the instrument.

1.4.4  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

1.4.5  Instrument security procedures

Deals with security issues when working with the R&S SMW in secure areas. It is avail-
able for download on the internet.

1.4.6  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

1.4.7  Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMW. It also lists the
options and their order numbers and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/smw200a

Documentation overview

https://gloris.rohde-schwarz.com
http://www.rohde-schwarz.com/brochure-datasheet/smw200a
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1.4.8  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The software makes use of several valuable open source software packages. An open-
source acknowledgment document provides verbatim license texts of the used open
source software.

See www.rohde-schwarz.com/firmware/smw200a

1.4.9  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/smw200a and www.rohde-schwarz.com/
manual/smw200a

1.4.10  Videos

Find various videos on Rohde & Schwarz products and test and measurement topics
on YouTube: https://www.youtube.com/@RohdeundSchwarz

On the menu bar, search for your product to find related videos.

Figure 1-1: Product search on YouTube

Documentation overview

http://www.rohde-schwarz.com/firmware/smw200a
http://www.rohde-schwarz.com/application/smw200a
http://www.rohde-schwarz.com/manual/smw200a
http://www.rohde-schwarz.com/manual/smw200a
https://www.youtube.com/@RohdeundSchwarz
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1.5  Scope

Tasks (in manual or remote operation) that are also performed in the base unit in the
same way are not described here.
In particular, it includes:
● Managing settings and data lists, like saving and loading settings, creating and

accessing data lists, or accessing files in a particular directory.
● Information on regular trigger, marker and clock signals and filter settings, if appro-

priate.
● General instrument configuration, such as checking the system configuration, con-

figuring networks and remote operation
● Using the common status registers

For a description of such tasks, see the R&S SMW user manual.

1.6  Notes on screenshots

When describing the functions of the product, we use sample screenshots. These
screenshots are meant to illustrate as many as possible of the provided functions and
possible interdependencies between parameters. The shown values may not represent
realistic usage scenarios.

The screenshots usually show a fully equipped product, that is: with all options instal-
led. Thus, some functions shown in the screenshots may not be available in your par-
ticular product configuration.

Notes on screenshots
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2  About the GBAS option

2.1  Required options

The equipment layout for generating GBAS signals includes the options:
● Standard baseband or wideband generator (R&S SMW-B10/B9) per signal path

Alternatively, high signal dynamics baseband or wideband generator (R&S SMW-
B10F/B9F) per signal path

● Baseband main module, one/two I/Q paths to RF (R&S SMW-B13/-B13T) or wide-
band baseband main module (R&S SMW-B13XT)

● Digital standard GBAS (R&S SMW-K111) per signal path
● Frequency option (e.g. R&S SMW-B1003)

2.2  About GBAS

The R&S SMW-K111 option enables you to define and configure the very high fre-
quency (VHF) Data Broadcast (VDB) Signal-in-Space signal. VDB signals are transmit-
ted from the Ground-Based Augmentation System (GBAS) ground subsystem to the
airborne subsystem. This implementation is in line with the specification RTCA
DO-246D. The instrument generates the GBAS signal at the physical layer and
includes configuration of the application data.

The GBAS is a ground-based augmentation system that could among other things
enhance satellite navigation to provide a position estimation of less than 1 meter. The
GBAS is intended to improve aircraft safety and to enhance satellite navigation and the
full range of precision approach and landing procedures, as well as the terminal area
operations. GBAS could replace the Instrument Landing System (ILS) and the Micro-
wave Landing System (MLS) in many applications.

GBAS components

The illustration in Figure 2-1 is a simplified representation of the GBAS three main
components:
● The GNSS satellite subsystem
● The airborne subsystem
● The GBAS ground subsystem

The ground equipment consists of four reference GNSS receivers at exactly defined
positions around the airport, GBAS ground station, and a VHF data broadcast transmit-
ter (VDB).

About GBAS
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Figure 2-1: GBAS components and signals (simplified representation)

1 = GNSS reference receiver
2 = GBAS ground station
3 = VHF data broadcast (VDB) transmitter
a = GNSS navigation message
b = Pseudorange
c = GBAS Correction message
d = VDB signal

The GBAS GNSS reference receiver receives the GNSS navigation message, per-
forms pseudorange measurements and transmits this information to the GBAS ground
station. The GBAS ground station determines errors in the calculated positions, adds
additional parameters and approach path information, produces a GBAS correction
message and sends it the VDB transmitter. The VDB transmitter modulates and enco-
des this message and broadcasts it to the airborne GBAS equipment, for example a
GBAS receiver in the airplane. The GBAS equipment in the airplane is a high-precision
multimode receiver that evaluates the message and applies corrections parameters to
improve the navigation algorithms from GPS.

This list outlines the three signals transmitted between the components which are
referred as GBAS Signal-in-Space:
● GNSS satellite to GBAS ground subsystem navigation signal
● GNSS satellite to GBAS airborne subsystem navigation signal
● GBAS ground subsystem to GBAS airborne subsystem VHF data broadcast

This firmware option enables you to generate the VHF data broadcast

Carrier frequencies and frequency channels

The VHF data broadcast is defined for carrier frequencies within the range of 108.025
MHz to 117.975 MHz and carrier spacing of 25.0 kHz.

About GBAS
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The R&S SMW supports the whole required frequency range; you can modulate the
VHF signal on any one of these carrier frequencies. Moreover, this firmware option
supports two frequency allocation modes, a single frequency and a multiple frequency
transmission.

When you chose the frequency allocation mode, consider the following:
● Single frequency mode is suitable to simulate the signal of up to eight VDB trans-

mitters modulated on the same carrier frequency.
The signal calculation is fast and optimized for time sensitive applications.
This mode is also the choice if the DUT or the analyzing equipment supports single
band decoding.

● Multi-frequency mode is suitable to allocate the VDB transmitters to up to 8 out of
11 adjacent frequency channels.
The generated signal is optimized for reduced adjacent and co-channel interfer-
ence to neighboring systems. The setting time, however, increase significantly
compared to the single frequency mode.

Broadcast timing structure

The broadcast is a Time Division Multiple Access (TDMA). According to the GBAS
specification RTCA DO-246D, the TDMA timing structure uses a two level hierarchy,
composed of 500 ms long frames, each divided into 8 VDB time slots (A - H), see Fig-
ure 2-2.

About GBAS
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Figure 2-2: TDMA timing structure (simplified representation)

A VDB time slot is the minimum resource that an individual VDB transmitter can use.
During one time slot, a VDB transmitter transmits exactly one burst.

The GBAS specification RTCA DO-246D defines the TDMA timing structure, including
timing budget of the VDB bursts, burst data contents and message encoding in great
details. The R&S SMW generates the required training sequence, encodes the mes-
sage according to RTCA DO-246D and applies the D8PSK modulation automatically,
so that you can concentrate on the configuration of the mandatory application data.
Optional application data defined in RTCA DO-246D is beyond the scope of this imple-
mentation.

To allocate the VDB in the time domain, use the scheduling settings, see Chap-
ter 3.4.2, "Scheduling settings", on page 48.

Refer to Figure 2-3 for illustration on how a multi-frequency TDMA scheduling is per-
formed in this implementation.

About GBAS
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Figure 2-3: Example of a multi-frequency TDMA scheduling

Power settings

In the R&S SMW, the following parameters have impact on the signal power of the time
slots:
● RF output power ("Status Bar > Level")

Defines the RMS level of the generated signal
● Relative power per time slot ("GBAS > Allocation > VDB# > Scheduling > Slot A

to H > Power")
Sets the relative power of a VDB per time slot (Slot A to H).

● Power generation mode ("GBAS > Gated Power Mode")
Defines the way the absolute power of a VDB per time slot is calculated.
The absolute power of a single time slot depends on the power settings of the
remaining time slots.
See Example"Calculating the power per time slot in "Gated Power Mode > Off""
on page 17 and Example"Calculating the power per time slot in "Gated Power
Mode > On"" on page 17 for explanation on how the parameter "Gated Power
Mode" influence the calculation.

About GBAS
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Example: Calculating the power per time slot in "Gated Power Mode > Off"
● "Level = - 30 dBm"
● "TS1 > State > On", relative power "TS1 > Pow(dB) = 0 dB"
● "TS3 > State > On", relative power "TS3 > Pow(dB) = 0 dB"
● "TS2/TS4/TS5/TS6/TS7/TS8 > State > Off"

"TS2/TS4/TS5/TS6/TS7/TS8 > Pow(dB) = -inf"

The absolute power of both scheduled time slots is PTS1 = PTS3 = -24 dBm.

Example: Calculating the power per time slot in "Gated Power Mode > On"
● "Level = - 30 dBm"
● "TS1 > State > On", relative power "TS1 > Pow(dB) = 0 dB"
● "TS3 > State > On", relative power "TS3 > Pow(dB) = -3 dB"
● "TS2/TS4/TS5/TS6/TS7/TS8 > State > Off"

"TS2/TS4/TS5/TS6/TS7/TS8 > Pow(dB) = -inf"

The absolute power of the scheduled time slots is:
● PTS1 = -30 dBm
● PTS3 = -33 dBm.

Supported message types

The GBAS specification RTCA DO-246D defines the following mandatory message
types. This implementation supports all required message types. Refer to Table 2-1 for
information on where to find the related settings.
Table 2-1: Overview of the required message types

Message type Description Related settings

1 Differential corrections

100 sec smoothed pseudor-
anges

Chapter 3.3.1, "Message type 1 & 11 set-
tings", on page 24

2 GBAS-related data Chapter 3.3.2, "Message type 2 settings",
on page 26

About GBAS
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Message type Description Related settings

4 Final Approach Segment
(FAS) construction data

Chapter 3.3.3.2, "FAS data settings",
on page 36

 Terminal Area Path (TAP)
construction data

Chapter 3.3.3.3, "TAP data settings",
on page 39

11 Differential corrections

30 sec smoothed pseudor-
anges

Chapter 3.3.1, "Message type 1 & 11 set-
tings", on page 24

Rohde&Schwarz solution for radio analysis
If your task requires verifications and measurements of GBAS installations on the
ground and in the air, consider to use the R&S®EVS300 ILS/VOR analyzer.
This instrument is a portable level and modulation analyzer. If equipped with the
required options, it is capable to perform VHF data link measurements on GBAS and
measurements on conventional ILS ground systems and VOR systems.

About GBAS
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3  GBAS configuration and settings
Access:

► Select "Baseband > GBAS".

The remote commands required to define these settings are described in Chapter 6,
"Remote-control commands", on page 66.

Settings:

● General settings......................................................................................................19
● Transmitter settings.................................................................................................22
● Message configuration settings...............................................................................24
● Allocation and frequency/scheduling settings......................................................... 46

3.1  General settings

Access:

► Select "Baseband > GBAS > General".

The dialog provides access to the default, "Save/Recall" settings, general GBAS
settings and access to dialogs with further settings.

Settings:

State..............................................................................................................................19
Set to Default................................................................................................................ 20
Save/Recall................................................................................................................... 20
Generate Waveform......................................................................................................20
Mode............................................................................................................................. 21
Gated Power Mode....................................................................................................... 21
Filter/Clipping Settings.................................................................................................. 21

State
Activates the GBAS standard.

General settings
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Activation of the standard disables all the other digital standards and digital modulation
modes in the same baseband.
Remote command: 
[:SOURce<hw>]:BB:GBAS:STATe on page 75

Set to Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Parameter Value

State Not affected by the "Set to Default"

Mode GBAS

Gated Power Mode On

Sample Rate Variation 10.5 kHz

Filter Cosine

Clipping Off

Trigger Auto

Clock Internal

Remote command: 
[:SOURce<hw>]:BB:GBAS:PRESet on page 73

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
See also, chapter "File and Data Management" in the R&S SMW user manual.
Remote command: 
[:SOURce<hw>]:BB:GBAS:SETTing:CATalog? on page 73
[:SOURce<hw>]:BB:GBAS:SETTing:DELete on page 74
[:SOURce<hw>]:BB:GBAS:SETTing:LOAD on page 74
[:SOURce<hw>]:BB:GBAS:SETTing:STORe on page 74

Generate Waveform
With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension *.wv. You
can define the filename and the directory, in that you want to save the file.
Using the ARB modulation source, you can play back waveform files and/or process
the file to generate multi-carrier or multi-segment signals.
Remote command: 
[:SOURce<hw>]:BB:GBAS:WAVeform:CREate on page 75

General settings
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Mode
Enables header information for the set GBAS mode, i.e. the corresponding landing
system.
The modulation and TDMA schemes of both systems are identical. Table 3-1 lists the
set header bytes for each landing system.
Table 3-1: Header start byte

Landing system Header start byte

GBAS (LAAS) 0xAAh

SCAT-I 0x99h

"GBAS" Enables GBAS (LAAS) header information conforming with specifica-
tion RTCA DO-246D.

"SCAT-I" Enables SCAT-I header information conforming with specification
RTCA DO-217.

Remote command: 
[:SOURce<hw>]:BB:GBAS:MODE on page 73

Gated Power Mode
Activates gated power mode, see "Power settings" on page 16.
Remote command: 
[:SOURce<hw>]:BB:GBAS:GPOW on page 72

Filter/Clipping Settings...
Accesses the dialog for setting baseband filtering, clipping and modulation, see Chap-
ter 4.1, "Filter/clipping settings", on page 52.

General settings
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3.2  Transmitter settings

Access:

► Select "GBAS > Transmitters".

The dialog comprises the settings, necessary to configure the VHF Data Broadcast
(VDB) signals.

Settings

State..............................................................................................................................22
GBAS ID........................................................................................................................22
SSID..............................................................................................................................23
Data/Data Configuration................................................................................................23
App. Data Length/bytes.................................................................................................23
Number of Frames........................................................................................................ 24
Append, Insert, Delete.................................................................................................. 24

State
Enables the selected VHF Data Broadcast (VDB) transmitter.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:STATe on page 77

GBAS ID
Sets the GBAS ID, that is a four-character (24-bit) alphanumeric field that identifies the
ground station broadcasting the message. Permitted are capital letter, numbers and
"space".
To identify a ground station, the airborne receiver examines the combination of the
GBAS ID and the SSID.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:GID on page 77

Transmitter settings
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SSID
Sets the station slot identifier SSID/RSID of the ground station.
According to RTCA DO-246D, the SSID is a numeric value from 0 to 7, corresponding
to the letter designation (A through H) of the first time slot assigned to a particular
ground reference station, where slot A = 0 and slot H = 7. All messages in all time slots
employed by a particular ground station use the same SSID.
To identify a ground station, the airborne receiver examines the combination of the
GBAS ID and the SSID.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SSID on page 77

Data/Data Configuration
Selects the data source for the VDB.
The following standard data sources are available:
● "All 0, All 1"

An internally generated sequence containing 0 data or 1 data.
● "PNxx"

An internally generated pseudo-random noise sequence.
● "Pattern"

An internally generated sequence according to a bit pattern.
Use the "Pattern" box to define the bit pattern.

● "Data List/Select DList"
A binary data from a data list, internally or externally generated.
Select "Select DList" to access the standard "Select List" dialog.
– Select the "Select Data List > navigate to the list file *.dm_iqd > Select" to

select an existing data list.
– Use the "New" and "Edit" functions to create internally new data list or to edit

an existing one.
– Use the standard "File Manager" function to transfer external data lists to the

instrument.
See also:
● Section "Modulation Data" in the R&S SMW user manual.
● Section "File and Data Management" in the R&S SMW user manual.
● Section "Data List Editor" in the R&S SMW user manual

"Real GBAS Data"
Enables you to configure the content of the GBAS messages.
Select "Data Config > Message Config..." to access the provided set-
tings.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA on page 78
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:DSELection on page 78
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:PATTern on page 79

App. Data Length/bytes
Sets the application data length.
For "Data/Data Configuration > Real GBAS Data", the value of the application data
length is not variable but is automatically set and calculated.
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Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DLENgth on page 78

Number of Frames
Displays the automatically calculated number of frames of the selected VDB.
Remote command: 
[:SOURce<hw>]:BB:GBAS:NOFRames? on page 76

Append, Insert, Delete
You can configure up to 8 VDB transmitters. Use the appropriate general functions:
"Append" Adds a new row in the table of VDB transmitters.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB:APPend on page 76

"Insert" Adds a new row above the currently selected one.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:INSert on page 76

"Delete" Deletes the selected row.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DELete on page 76

3.3  Message configuration settings

Access:

1. Select "GBAS > Transmitters".

2. Select "VDB# > Data > Real Data".

3. Select "Data Configiguration > Message Config...".

The dialog "VDB#: Message Configuration" provides settings to configure message
types 1, 2, 4 and 11.

Settings

● Message type 1 & 11 settings................................................................................. 24
● Message type 2 settings......................................................................................... 26
● Message type 4 settings......................................................................................... 34

3.3.1  Message type 1 & 11 settings

Differential GNSS is an approach that uses known GNSS reference locations to deter-
mine channel correction parameters. The retrieved information is transmitted to other
GNSS receivers to increase the accuracy of their position information.
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Access:

1. Select "Data Configuration > Message Config...", see Chapter 3.3, "Message con-
figuration settings", on page 24.

2. Select "VDB#: Message Configuration > Message Type 1 & 11"

The dialog provides settings to manage GBAS differential data.

For step-by-step description on how to load GBAS differential data, see Chapter 5.1,
"Loading differential GBAS data", on page 65.

Settings

Message Type 1............................................................................................................25
Message Type 11.......................................................................................................... 25
Differential Corrections File ..........................................................................................25
Predefined Files............................................................................................................ 26

Message Type 1
Activates the use of message type 1, differential GPS corrections.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:M1STate on page 82

Message Type 11
Activates the use of the message type 11, C/A-Code L1, L2 delta corrections.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:M11State on page 82

Differential Corrections File ...
Accesses the "Proprietary File" dialog to select a file containing differential GBAS infor-
mation.
The differential GBAS file must have the extension *.rs_gbas and file format as
described in Chapter A.2, "GBAS differential file format", on page 122.
The differential SCAT-I file must have the extension *.rs_scat and file format as
described in Chapter A.3, "SCAT-I differential file format", on page 125.
Select "Predefined Files" to load a predefined file.
Remote command: 
For "Mode > GBAS":
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:FILE? on page 85
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:CATalog? on page 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:FILE on page 84
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For "Mode > SCAT-I":
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SFILe? on page 85
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SUSer:CATalog on page 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SUSer:FILE on page 83

Predefined Files
Accesses a list with predefined files.
Remote command: 
For "Mode > GBAS":
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:CATalog?
on page 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:FILE
on page 84
For "Mode > SCAT-I":
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:CATalog
on page 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:FILE
on page 83
For waypoint files:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:
CATalog? on page 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:FILE
on page 109

3.3.2  Message type 2 settings

Access:

1. Select "Data Configuration > Message Config...", see Chapter 3.3, "Message con-
figuration settings", on page 24.

2. Select "VDB#: Message Configuration > Message Type 2"
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The dialog provides settings to configure message type 2 parameters according to
RTCA DO-246D, Table 2.14.

Message type 2 carries information on the exact location and other GBAS-related
parameters.

Settings

● General settings......................................................................................................27
● Location settings..................................................................................................... 29
● Additional data block 1 settings...............................................................................30
● Additional data block 3 settings...............................................................................32
● Additional data block 4 settings...............................................................................33

3.3.2.1  General settings

Access:

1. Select "VDB#: Message Configuration > Message Type 2 > General Settings".

2. Select "Message Type 2 > On"

The dialog provides general settings to configure message type 2 parameter
according to RTCA DO-246D, Table 2.14.

Settings

Message Type 2............................................................................................................27
Ground Station Reference Receivers........................................................................... 27
Ground Station Accuracy Designator............................................................................28
GS Continuity/Integrity Designator................................................................................28
Local Magnetic Variation............................................................................................... 28
Sigma_vert_iono_gradient............................................................................................ 28
Refractivity Index...........................................................................................................28
Scale Height..................................................................................................................28
Refractivity Uncertainty................................................................................................. 28

Message Type 2
Enables you to configure the parameters of message type 2, according to RTCA
DO-246D, Table 2.14.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT2State on page 86

Ground Station Reference Receivers
Selects the number of the GNSS reference receivers installed in this system.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSRReceivers on page 87
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Ground Station Accuracy Designator
Selects the letter designator indicating the minimum signal-in-space accuracy perfor-
mance provided by the ground station.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSADesignator on page 87

GS Continuity/Integrity Designator
Selects the numerical designator that indicates the operational status of GBAS.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GCID on page 87

Local Magnetic Variation
Sets the published local magnetic variation at the differential reference point. A positive
value represents an east variation (clockwise from true north).
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LMVariation on page 88

Sigma_vert_iono_gradient
Sets the parameter σvert_iono_gradient, that is the standard deviation of a normal distribu-
tion associated with the residual ionospheric uncertainty due to spatial decorrelation.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVIGradient on page 89

Refractivity Index
Sets the estimated tropospheric refractivity index NR at the reference point.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RFINdex on page 88

Scale Height
Sets the parameter scale height (h0), used for scaling the tropospheric refractivity as a
function of differential altitude.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SHEight on page 89

Refractivity Uncertainty
Sets the parameter σN, that is the standard deviation of a normal distribution associ-
ated with the residual tropospheric uncertainty.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUNCertainty on page 88
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3.3.2.2  Location settings

Access:

► Select "VDB#: Message Configuration > Message Type 2 > Location Settings".

The dialog provides location settings to configure message type 2 parameter
according to RTCA DO-246D, Table 2.14.

Settings

Reference Location Configuration.................................................................................29

Reference Location Configuration
The coordinates of the ground station reference point are defined in WGS84 coordi-
nates. In this coordinate system, a location is identified by three coordinates, the alti-
tude, the latitude and the longitude. The last two can be displayed in decimal or DMS
format. Use the parameter "Position Format" to select the display format.
Table 3-2: Reference location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Altitude" Sets the altitude of the ground station reference point, that is the height above
the ellipsoid (HAE) altitude.

"Latitude" Sets the latitude of the ground station reference point.

"Longitude" Sets the longitude of the ground station reference point.
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Remote command: 
To specify the position format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:
FORMat on page 93
To enter the coordinates in Degree:Minute:Second format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DMS
on page 92
To enter the coordinates in decimal degree format
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:
DECimal on page 92

3.3.2.3  Additional data block 1 settings

Access:

► Select "VDB#: Message Configuration > Message Type 2 > Additional Data Block
1".

The dialog provides additional data block 1 settings to configure message type 2
parameter according to RTCA DO-246D, Table 2.14.

Settings

Additional Data Block 1................................................................................................. 30
Positioning Service........................................................................................................31
Reference Station Data Selector...................................................................................31
Maximum User Distance............................................................................................... 31
Kmd_e_C,GPS/Kmd_e_C,GLONASS.......................................................................... 31
Kmd_e_POS,GPS/Kmd_e_POS,GLONASS................................................................ 31

Additional Data Block 1
Enables you to configure the additional data block 1.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB1:STATe on page 86
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Positioning Service
Selects if the GBAS positioning service is supported.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:PSERvice:STATe on page 90

Reference Station Data Selector
Requires "Positioning Service > On".
Sets the numerical identifier for selecting the ground subsystem.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RSDSelector on page 90

Maximum User Distance
Sets the maximum distance from the reference point for which the integrity is assured.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MUDistance on page 90

Kmd_e_C,GPS/Kmd_e_C,GLONASS
Sets the ephemeris missed detection parameter (Kmd_e), category I precision
approach and approach with vertical guidance (APV). This is a multiplier considered
when calculating the ephemeris error position bound for the category I precision
approach and APV. It is derived from the probability that a detection is missed because
of an ephemeris error in a GPS/GLONASS satellite.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KCGLonass on page 89
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KCGPs on page 89

Kmd_e_POS,GPS/Kmd_e_POS,GLONASS
Sets the ephemeris missed detection parameter (Kmd_e), GBAS positioning service.
This is a multiplier considered when calculating the ephemeris error position bound for
the GBAS positioning. It is derived from the probability that a detection is missed
because of an ephemeris error in a GPS/GLONASS satellite.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KPGLonass on page 90
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KPGPs on page 90
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3.3.2.4  Additional data block 3 settings

Access:

► Select "VDB#: Message Configuration > Message Type 2 > Additional Data Block
3".

The dialog provides additional data block 3 settings to configure message type 2
parameter according to RTCA DO-246D, Table 2.14.

Settings

Additional Data Block 3................................................................................................. 32
Kmd_e_D,GPS/Kmd_e_D,GLONASS.......................................................................... 32
Sigma_vert_iono_gradient_D........................................................................................32

Additional Data Block 3
Enables you to configure the parameters of the additional block 3, containing the
GBAS approach service type (GAST) D parameters.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB3:STATe on page 86

Kmd_e_D,GPS/Kmd_e_D,GLONASS
Sets the ephemeris missed detection parameter (Kmd_e), GAST D. This is a multiplier
considered when calculating the ephemeris error position bound for GAST D. It is
derived from the probability that a detection is missed because of an ephemeris error
in a GPS/GLONASS satellite.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KDGLonass on page 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KDGPs on page 91

Sigma_vert_iono_gradient_D
Sets the standard deviation of a normal distribution connected to the residual iono-
spheric uncertainty which is caused by spatial decorrelation.
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Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVID on page 91

3.3.2.5  Additional data block 4 settings

Access:

► Select "VDB#: Message Configuration > Message Type 2 > Additional Data Block
4".

The dialog provides additional data block 4 settings to configure message type 2
parameter according to RTCA DO-246D, Table 2.14.

Settings

Additional Data Block 4................................................................................................. 33
Slot Group Definition..................................................................................................... 33

Additional Data Block 4
Enables you to configure the parameters of the additional block 4, containing the VDB
authentication parameters.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB4:STATe on page 87

Slot Group Definition
Specifies which slots are used by the ground station. You can activate slots "A" to "H".
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:A:STATe
on page 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:B:STATe
on page 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:C:STATe
on page 91
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:D:STATe
on page 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:E:STATe
on page 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:F:STATe
on page 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:G:STATe
on page 92
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:H:STATe
on page 92

3.3.3  Message type 4 settings

Access:

1. Select "Data Config > Message Config...", see Chapter 3.3, "Message configura-
tion settings", on page 24.

2. Select "VDB#: Message Configuration > Message Type 4"

The dialog provides settings to configure message type 4 parameters.

For "Mode > GBAS", the settings conform with specification RTCA DO-246D.

For "Mode > SCAT-I", the settings conform with specification RTCA DO-217.

According to the RTCA DO-246D, the message type 4 contains one or more data sets
that contain approach data, associated vertical/lateral alert limits, and/or the Terminal
Area Path (TAP).

You can configure the Final Approach Segment (FAS) data set, the TAP data set or
both.
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TAP data is not available for "Mode > SCAT-I".

Settings

● General settings......................................................................................................35
● FAS data settings....................................................................................................36
● TAP data settings....................................................................................................39
● Location settings..................................................................................................... 42

3.3.3.1  General settings

Access:

► Select "VDB#: Message Configuration > Message Type 4".

The dialog provides general settings to enable message type 4 parameters.

Settings

Message Type 4............................................................................................................35

Message Type 4
Enables you to configure the parameters of message type 4, according to RTCA
DO-246D, Table 2.18.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT4State on page 95
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3.3.3.2  FAS data settings

Access:

► Select "VDB#: Message Configuration > Message Type 4 > FAS Data".

The dialog comprises FAS data settings to configure message type 4 parameter
according to RTCA DO-246D, Table 2.14.

FAS data is required for both "GBAS" (LAAS) and "SCAT-I" header information modes.
Unless stated otherwise, the settings below hold for both modes.

Settings

FAS Data Set................................................................................................................ 36
Plan View/Profile View Parameters...............................................................................37
Airport ID....................................................................................................................... 38
Runway Number........................................................................................................... 38
Runway Letter............................................................................................................... 38
Approach Performance Designator...............................................................................38
Route Indicator..............................................................................................................38
Reference Path Data Selector...................................................................................... 38
Reference Path ID.........................................................................................................39
Course Width at Threshold........................................................................................... 39
Delta_Length Offset...................................................................................................... 39
FAS Vertical Alert Limit / Approach Status.................................................................... 39
FAS Lateral Alert Limit / Approach Status.....................................................................39

FAS Data Set
Requires "Mode > GBAS" (LAAS) header information.
Enables you to configure the parameters of the Final Approach Segment (FAS) data
set.
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Provided are the parameters necessary to configure a single precision approach. The
FAS path is a line in space that defines the path an airplane follows on its final
approach. This line is defined by the Landing Threshold Point/Fictitious Threshold
Point (LTP/FTP), Flight Path Alignment Point (FPAP), Threshold Crossing Height
(TCH), and the Glide Path Angle (GPA).
The dialog displays also two graphs, a "Plan View" and a "Profile View", to visualize a
typical final approach path.

Figure 3-1: Final Approach Segment (FAS) diagram, according to RTCA DO-246D

LTP/FTP = Landing Threshold Point/Fictitious Threshold Point; point at the center of the landing runway,
defined by its WGS84 coordinates

GPIP = Glide Path Intercept Point; the point where the final approach path intercepts the local level plane
FPAP = Flight Path Alignment Point; point at the end of the runway that in conjunction with the LTP/FTP

defines the geodesic plane of the precision final approach, landing and flight path.
TCH = Threshold Crossing Height
GAP = Glide Path Angle; angle at the TCH that describes the intended angle of descent at the final

approach path.

Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDSState on page 95

Plan View/Profile View Parameters
Requires "Mode > GBAS" (LAAS) header information.
The following parameters define the approach path (see also Figure 3-1):
"Glide Path Angle"

Sets the angle of the FAS path (glide path) with respect to the hori-
zontal plane tangent to the WGS84 ellipsoid at the LTP/FTP.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GPANgle
on page 103
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"TCH" Sets the threshold crossing height (TCH) , that is the height of the
FAS path above the LTP/FTP defined in either feet or meters.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATCHeight
on page 96
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATUSelector
on page 96

"LTP/FTP Height"
Sets the height of the LTP/FTP above the WGS84 ellipsoid.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:
HEIGht on page 105

Airport ID
Sets the airport identification as three or four alphanumeric characters used to desig-
nate airport facilities. Permitted are upper letters, numbers and "space".
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:AID on page 95

Runway Number
Sets the approach runway number.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RNUMber on page 106

Runway Letter
Sets the runway letter, to distinguish between parallel runways. The conventional des-
ignation is used.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RLETter on page 105

Approach Performance Designator
Requires "Mode > GBAS" (LAAS) header information.
Sets the general information about the approach design. The conventional designation
is used.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:APDesignator on page 96

Route Indicator
Sets the route indicator, that is a single alphabetic character used to differentiate
between multiple approaches to the same runway end. Allowed are the upper case let-
ters, excluding “I” and “O”, or the “space” character.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUINdicator on page 106

Reference Path Data Selector
Sets the reference path data selector (RPDS), that is a numerical identifier that is
unique on a frequency in the broadcast region and used to select the FAS.
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Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDF on page 106

Reference Path ID
Sets the reference path identifier as three or four alphanumeric characters used to des-
ignate the reference path.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIF on page 106

Course Width at Threshold
Requires "Mode > GBAS" (LAAS) header information.
Sets the lateral displacement from the path defined by the FAS at the LTP/FTP at
which full-scale course deviation indicator (CDI) deflection is attained.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:CWAThreshold on page 97

Delta_Length Offset
Requires "Mode > GBAS" (LAAS) header information.
Sets the parameter delta length (ΔLength) offset, that is the distance from the stop end
of the runway to the FPAP.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DLOFfset on page 99

FAS Vertical Alert Limit / Approach Status
Sets the value of the broadcast vertical alert limit.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FVAA on page 102

FAS Lateral Alert Limit / Approach Status
Sets the value of the broadcast lateral alert limit.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FLAA on page 102

3.3.3.3  TAP data settings

Requires "Mode > GBAS" (LAAS) header information.
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Access:

► Select "VDB#: Message Configuration > Message Type 4 > TAP Data".

The dialog comprises TAP data settings to configure message type 4 parameter
according to RTCA DO-246D, Table 2.14.

Settings

TAP Data Set.................................................................................................................40
Reference Path Data Selector...................................................................................... 40
Reference Path ID.........................................................................................................41
Number of Path Points - N............................................................................................ 41
Waypoint File.................................................................................................................41
Predefined Files............................................................................................................ 41
FAS RPDS or Continuation Link................................................................................... 42
TAP Vertical Alert Limit / Status.....................................................................................42
TAP Lateral Alert Limit / Status..................................................................................... 42

TAP Data Set
Enables you to configure the parameters of the Terminal Area Path (TAP) data set.
A TAP defines the initial fix (IF), track-to-fix (TF) and radius-to-fix (RF) legs and pro-
vides additional support for terminal area operations.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TDSState on page 107

Reference Path Data Selector
Sets the reference path data selector.
This parameter is a numerical identifier that is unique on a frequency in the broadcast
region and used to select the TAP.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDT on page 108
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Reference Path ID
Sets the reference path identifier as three or four alphanumeric characters used to des-
ignate the reference path.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIT on page 108

Number of Path Points - N
Indicates the total number of path points included in this TAP.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:NOPPoint on page 107

Waypoint File
Accesses the "Select Waypoint File" dialog to select predefined or user-defined way-
point files.
A waypoint file is description of a moving scenario, like, for example, a sequence of
positions. A waypoint file must have the extension *.txt and file format as described
in Chapter A.1, "Waypoint file format", on page 122.
Use the "Predefined Files" function, to load a predefined file.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:
CATalog? on page 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:CATalog?
on page 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:FILE
on page 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:FILE
on page 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:FILE? on page 110

Predefined Files
Accesses a list with predefined files.
Remote command: 
For "Mode > GBAS":
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:CATalog?
on page 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:FILE
on page 84
For "Mode > SCAT-I":
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:CATalog
on page 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:FILE
on page 83
For waypoint files:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:
CATalog? on page 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:FILE
on page 109
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FAS RPDS or Continuation Link
Sets the FAS reference path data selector (RPDS) or the continuation link. Continua-
tion link is the RPDS for the next segment that is a continuation of the previous seg-
ment.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FRCLink on page 107

TAP Vertical Alert Limit / Status
Requires "Mode > GBAS" (LAAS) header information.
Sets the value of the broadcast vertical alert limit.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TVAS on page 108

TAP Lateral Alert Limit / Status
Requires "Mode > GBAS" (LAAS) header information.
Sets the value of the broadcast lateral alert limit.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TLAS on page 108

3.3.3.4  Location settings

Access:

► Select "VDB#: Message Configuration > Message Type 4 > Location".

The dialog comprises location data settings to configure message type 4 parame-
ter according to RTCA DO-246D, Table 2.14.

For "Mode > GBAS" (LAAS) header information, configure LTP/FTP Location Configu-
ration and Delta_FPAP Location Configuration settings.
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For "Mode > SCAT-I" header information, configure DP Location Configuration and
Delta_DERP Location Configuration settings.

Settings

LTP/FTP Location Configuration................................................................................... 43
Delta_FPAP Location Configuration..............................................................................43
DP Location Configuration............................................................................................ 44
Delta_DERP Location Configuration.............................................................................45

LTP/FTP Location Configuration
Requires "Mode > GBAS" (LAAS) header information.
The coordinates of the LTP/FTP are defined in WGS84 coordinates. In this coordinate
system, a location is identified by three coordinates, the altitude, the latitude and the
longitude. The last two can be displayed in decimal or DMS format. Use the parameter
"Position Format" to select the display format.
Use the parameter LTP/FTP Height to define the altitude.
Table 3-3: LTP/FTP location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Latitude" Sets the latitude of the LTP/FTP in arc seconds.

"Longitude" Sets the longitude of the LTP/FTP in arc seconds.

Remote command: 
To specify the position format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:
FORMat on page 105
To enter the coordinates in Degree:Minute:Second format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:DMS
on page 104
To enter the coordinates in decimal degree format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:
DECimal on page 103

Delta_FPAP Location Configuration
Requires "Mode > GBAS" (LAAS) header information.
The Delta FPAD (ΔFPAD) represents the difference of latitude/longitude of the runway
Flight Path Alignment Point (FPAP) from the LTP/FTP.
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The Delta FPAD coordinates are defined in WGS84 coordinates. In this coordinate sys-
tem, a location is identified by three coordinates, the altitude, the latitude and the longi-
tude. The last two can be displayed in decimal or DMS format. Use the parameter
"Position Format" to select the display format.
Table 3-4: Delta_FPAP location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Latitude" Sets the difference of latitude of the FPAP in arc seconds.

Positive values indicate the FPAP latitude north of LTP/FTP latitude.

"Longitude" Sets the difference of longitude of the FPAP in arc seconds.

Positive values indicate the FPAP longitude east of LTP/FTP longitude.

Remote command: 
To specify the position format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:
FORMat on page 98
To enter the coordinates in Degree:Minute:Second format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:DMS
on page 97
To enter the coordinates in decimal degree format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:
DECimal on page 97

DP Location Configuration
Requires "Mode > SCAT-I" header information.
The DP represents the threshold datum point (DP). The point is the tangential point
between the horizontal plane and WGS84 ellipsoid.
The DP coordinates are defined in WGS-84 coordinates. In this coordinate system, a
location is identified by three coordinates, the altitude, the latitude and the longitude.
The last two can be displayed in decimal or DMS format. Use the parameter "Position
Format" to select the display format.
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Table 3-5: DP location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Latitude" Sets the difference of latitude of the DP in arc seconds.

Positive values indicate the DP latitude north of TCP latitude.

"Longitude" Sets the difference of longitude of the DP in arc seconds.

Positive values indicate the DP longitude east of TCP longitude.

Remote command: 
To specify the position format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:
COORdinates:FORMat on page 102
To enter the coordinates in Degree:Minute:Second format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:
COORdinates:DMS on page 101
To enter the coordinates in decimal degree format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:
COORdinates:DECimal on page 101

Delta_DERP Location Configuration
Requires "Mode > SCAT-I" header information.
Sets the departure end of runway point (DERP) or stop-end point.
This point is typically located on the runway centerline at the end of the runway.
The Delta DERP coordinates are defined in WGS84 coordinates. In this coordinate
system, a location is identified by three coordinates, the altitude, the latitude and the
longitude. The last two can be displayed in decimal or DMS format. Use the parameter
"Position Format" to select the display format.
Table 3-6: Delta_DERP location configuration

Parameter Description

"Position Format" Sets the format in which the Latitude and Longitude are displayed.
● "DEG:MIN:SEC"

The display format is Degree:Minute:Second and Direction, i.e.
XX°XX'XX.XX" Direction, where direction can be North/South and
East/West.

● "Decimal Degree"
The display format is decimal degree, i.e. +/-XX.XXXXX°, where "+"
indicates North and East and "-" indicates South and West.

"Latitude" Sets the difference of latitude of the Delta_DERP in arc seconds.

Positive values indicate the Delta_DERP latitude north of LTP/FTP latitude.

"Longitude" Sets the difference of longitude of the Delta_DERP in arc seconds.

Positive values indicate the Delta_DERP longitude east of LTP/FTP longitude.
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Remote command: 
To specify the position format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:
COORdinates:FORMat on page 100
To enter the coordinates in Degree:Minute:Second format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:
COORdinates:DMS on page 99
To enter the coordinates in decimal degree format:
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:
COORdinates:DECimal on page 99

3.4  Allocation and frequency/scheduling settings

Access:

► Select "GBAS > Allocation".

This dialog comprises the allocation and scheduling settings of the VDB transmit-
ters and frequency channels.

Settings

● Allocation settings................................................................................................... 46
● Scheduling settings.................................................................................................48

3.4.1  Allocation settings

Access:

► Select "GBAS > Allocation".

Allocation and frequency/scheduling settings
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This dialog comprises the settings, necessary to configure the allocation of the
VDB transmitters "VDB#" on the selected frequency number "FN#".

Allocation table
Comprises the allocation of the VDB transmitters "VDB#" on the selected frequency
number "FN#".
There is one table row for each VDB transmitter as configured in Chapter 3.2, "Trans-
mitter settings", on page 22.

Scheduling ← Allocation table
Configure the time domain scheduling of VDB transmitters on the selected frequency
number.
Configuration requires, that the VDB transmitter is mapped to the frequency number.
Access scheduling settings via the icon , see Chapter 3.4.2, "Scheduling settings",
on page 48.

FN -5 to 5 ← Allocation table
Displays the frequency number and defines the frequency band the corresponding
VDB is using, see "Carrier frequencies and frequency channels" on page 13.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:FNUMber on page 77

Map VDB# to FN# ← Allocation table
The mapping of the VDB transmitters on frequency numbers "FN -5 to FN 5" is repre-
sented as a matrix. Listed are VDB transmitters and their "GBAS ID", as configured in
Chapter 3.2, "Transmitter settings", on page 22.

A blue matrix element  activates the VDB transmitter "VDB#" on the frequency num-
ber "FN#". Activation of one VDB transmitter on more than one frequency number is
not possible.
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3.4.2  Scheduling settings

Access:

1. Select "GBAS > Allocation".

2. Select "Allocation > Allocation Table > Scheduling > Configuration" via the icon .

The dialog provides settings to configure the time domain scheduling of the VDB
transmitters on the selected frequency.
The transmission is based on TDMA and hence on one particular frequency that
you can allocate only one VDB transmitter per one time slot ("Slot A" to "Slot H").
For more information, see "Broadcast timing structure" on page 14.

Settings

SSID..............................................................................................................................48
Slot A to Slot H..............................................................................................................49

└ State................................................................................................................49
└ Power Offset................................................................................................... 49

Show/Hide Message Output Rate.................................................................................49
Message scheduling table.............................................................................................49

└ Frame Cycle....................................................................................................50
└ Frame Offset................................................................................................... 50
└ Slot..................................................................................................................50
└ Max Bytes per Slot..........................................................................................50
└ Link Pair..........................................................................................................50
└ Bytes Overload > !!!........................................................................................ 51
└ Message Config..............................................................................................51

SSID
Sets the station slot identifier SSID/RSID of the ground station.
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According to RTCA DO-246D, the SSID is a numeric value from 0 to 7, corresponding
to the letter designation (A through H) of the first time slot assigned to a particular
ground reference station, where slot A = 0 and slot H = 7. All messages in all time slots
employed by a particular ground station use the same SSID.
To identify a ground station, the airborne receiver examines the combination of the
GBAS ID and the SSID.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SSID on page 77

Slot A to Slot H
Indicates, which VDBs are enabled in the time slots.

The information is color-coded. Icons provide further information:
● Blue: Enabled VDB in the time slot.
● Gray: VDBs are disabled in the time slot.
● Cross out: VDBs are excluded in the time slot, since another VDB is enabled in the

time slot.
● Power bar: Reduced height indicates, that the VDB is transmitted with less power.

The height of the power bar reflects enabled "Power Offset".

State ← Slot A to Slot H
Enables the VDB in the corresponding time slot (TS).
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:STATe on page 79

Power Offset ← Slot A to Slot H
Sets the power offset of a VDB per time slot.
For more information, see "Power settings" on page 16.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:POWer on page 80

Show/Hide Message Output Rate
Requires Data/Data Configuration > "Real GBAS Data".
Shows/hides message output details. The details are listed in the Message scheduling
table.

Message scheduling table
Requires Data/Data Configuration > "Real GBAS Data".
Lists, which message types are enabled on the time slots Slot A to Slot H.
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Frame Cycle ← Message scheduling table
Requires "Message Type 2/4".
Sets the repetition rate.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:RFRame? on page 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:RFRame? on page 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:RFRame on page 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:RFRame on page 81

Frame Offset ← Message scheduling table
Sets the frame offset compared to the first frame.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:FOFFset? on page 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:FOFFset? on page 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:FOFFset on page 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:FOFFset on page 80

Slot ← Message scheduling table
Assign the slot to the meassage type.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:SLOT<di>:STATe on page 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:SLOT<di>:STATe on page 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:SLOT<di>:STATe on page 82
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:SLOT<di>:STATe on page 82

Max Bytes per Slot ← Message scheduling table
Shows the total number of bytes per message type.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:MBYTes? on page 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:MBYTes? on page 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:MBYTes? on page 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:MBYTes? on page 81

Link Pair ← Message scheduling table
Requires "Message Type 1/11 > On".
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Specifies if the set of measurement blocks is included in a single message or in a
linked pair of messages.
Remote command: 
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:LPAir:STATe on page 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:LPAir:STATe on page 80

Bytes Overload > !!! ← Message scheduling table
Displays a warning, if too many bytes per slot are assigned.
If too many bytes per slot are assigned, you can pair messages (message type 1 and
11 only) or deactivate messages in the specific "Slot".

Message Config... ← Message scheduling table
Accesses the message configuration dialog via the icon .
For accessing the configuration of a specific message, tick the icon in the row, where
the corresponding message is.
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4  Signal generation control
This section lists settings provided for configuring the baseband filter, for defining the
signal generation start and for generating signals necessary for synchronization with
other instruments.

It covers the following topics:

● Filter/clipping settings..............................................................................................52
● Trigger settings....................................................................................................... 55
● Marker settings........................................................................................................61
● Clock settings..........................................................................................................63
● Local and global connectors settings......................................................................64

4.1  Filter/clipping settings

Access:

► Select "General > Filter/Clipping Settings".

The dialog comprises the settings to configure the baseband filter, modulation set-
tings and clipping.

4.1.1  Filter settings

Access:

► Select "General > Filter/Clipping Settings > Filter".

The dialog provides settings to configure the baseband filter.

Settings

Filter.............................................................................................................................. 53
Rolloff Factor or BxT..................................................................................................... 53
Cut Off Frequency Factor..............................................................................................53
Bandwidth to Symbol Rate Ratio.................................................................................. 53
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Filter
Selects the baseband filter.
Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:TYPE on page 112

Rolloff Factor or BxT
Sets the filter parameter.
The filter parameter ("Roll off Factor" or "BxT") depends on the currently selected filter
type. This parameter is preset to the default for each of the predefined filters.
Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:APCO25 on page 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine on page 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:GAUSs on page 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:PGAuss on page 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:RCOSine on page 112
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:SPHase on page 112

Cut Off Frequency Factor
Sets the value for the cutoff frequency factor. The cutoff frequency of the filter can be
adjusted to reach spectrum mask requirements.
Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASs on page 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASSEVM on page 111

Bandwidth to Symbol Rate Ratio
Requires "Filter > Cosine".
Sets the ratio between filter bandwidth and symbol rate.
Remote command: 
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine:COFS on page 111

4.1.2  Modulation settings

Access:

► Select "General > Filter/Clipping Settings > Modulation Settings".

The dialog provides settings to check the modulation type and set the sample rate
variation.
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Settings

Modulation Type............................................................................................................54
Sample Rate Variation/Sample Rate Info......................................................................54

Modulation Type
Displays the modulation type.
According to the GBAS standard, symbols are converted to differentially encoded 8
phase shift keyed (D8PSK) carrier phase shifts.
Remote command: 
[:SOURce<hw>]:BB:GBAS:MSET:MTYPe? on page 112

Sample Rate Variation/Sample Rate Info
Sets the sample rate variation in the "Filter/Clipping Settings > Modulation Settings"
dialog.
Displays the set sample rate variation in the "GBAS > General" dialog.
The sample rate variation parameter can be used for testing the symbol rate tolerance.
The RTCA DO-246D specification defines a symbol rate of the GBAS data broadcast
as 10500 Sym/s.
With GBAS using D8PSK modulation, each symbol defines one of eight states. This
results in a nominal bit rate of 31500 bits/s. See also "Modulation Type" on page 54.
Remote command: 
[:SOURce<hw>]:BB:GBAS:MSET:SRATe? on page 113
[:SOURce<hw>]:BB:GBAS:SRINfo? on page 113

4.1.3  Clipping settings

Access:

► Select "General > Filter/Clipping > Clipping".

The dialog provides settings to configure clipping.
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Settings

State..............................................................................................................................55
Clipping Level................................................................................................................55
Clipping Mode............................................................................................................... 55

State
Switches baseband clipping on and off.
Baseband clipping is a simple and effective way of reducing the crest factor of the sig-
nal. Since clipping is done before to filtering, the procedure does not influence the
spectrum. The EVM however increases.
Remote command: 
[:SOURce<hw>]:BB:GBAS:CLIPping:STATe on page 111

Clipping Level
Sets the limit for clipping.
This value indicates at what point the signal is clipped. It is specified as a percentage,
relative to the highest level. 100% indicates that clipping does not take place.
Remote command: 
[:SOURce<hw>]:BB:GBAS:CLIPping:LEVel on page 111

Clipping Mode
Selects the clipping method. The dialog displays a graphical illustration on how this two
methods work.
● "Vector | i + jq |"

The limit is related to the amplitude | i + q |. The I and Q components are mapped
together, the angle is retained.

● "Scalar | i | , | q |"
The limit is related to the absolute maximum of all the I and Q values | i | + | q |.
The I and Q components are mapped separately, the angle changes.

Remote command: 
[:SOURce<hw>]:BB:GBAS:CLIPping:MODE on page 111

4.2  Trigger settings

Access:

► Select "Baseband > GBAS > Trigger In".

Trigger settings
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This tab provides settings to select and configure the trigger, like trigger source,
trigger mode and trigger delays, and to arm or trigger an internal trigger manually.
The header of the tab displays the status of the trigger signal and trigger mode. As
in the tabs "Marker" and "Clock", this tab provides also access to the settings of the
related connectors.

Routing and activating a trigger signal

1. Define the effect of a trigger event and the trigger signal source.

a) Select "Trigger In" > "Mode".
b) Select "Trigger In" > "Source".

2. For external trigger signals, define the connector for signal input. See Chapter 4.5,
"Local and global connectors settings", on page 64.
You can map trigger signals to one or more USER x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMW starts baseband signal generation after the configured trigger
event.

About baseband trigger signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMW user manual.

Settings:

Trigger Settings Common to All Basebands................................................................. 56
Mode............................................................................................................................. 57
Signal Duration Unit...................................................................................................... 57
Signal Duration..............................................................................................................57
Time Based Trigger.......................................................................................................57
Trigger Time.................................................................................................................. 58
Running/Stopped.......................................................................................................... 58
Arm................................................................................................................................58
Execute Trigger.............................................................................................................58
Source...........................................................................................................................58
Sync. Output to External Trigger/Sync. Output to Trigger.............................................59
External Inhibit/Trigger Inhibit........................................................................................60
External Delay/Trigger Delay........................................................................................ 60

Trigger Settings Common to All Basebands
To enable simultaneous signal generation in all basebands, the R&S SMW couples the
trigger settings in the available basebands in any instrument's configuration involving
signal routing with signal addition. For example, in MIMO configuration, routing and
summing of basebands or of streams.
The icon  indicates that common trigger settings are applied.
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You can access and configure the common trigger source and trigger mode settings in
any of the basebands. An arm or a restart trigger event applies to all basebands, too.
You can still apply different delay to each of the triggers individually.

Mode
Selects trigger mode, i.e. determines the effect of a trigger event on the signal genera-
tion.
For more information, refer to chapter "Basics" in the R&S SMW user manual.
● "Auto"

The signal is generated continuously.
● "Retrigger"

The signal is generated continuously. A trigger event (internal or external) causes a
restart.

● "Armed Auto"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously.
An "Arm" stops the signal generation. A subsequent trigger event (internal or exter-
nal) causes a restart.

● "Armed Retrigger"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated continuously. Every subsequent trigger event causes a restart.
An "Arm" stops signal generation. A subsequent trigger event (internal or external)
causes a restart.

● "Single"
The signal is generated only when a trigger event occurs. Then the signal is gener-
ated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal or external) causes a restart.

Remote command: 
[:SOURce<hw>]:BB:GBAS[:TRIGger]:SEQuence on page 114

Signal Duration Unit
Defines the unit for describing the length of the signal sequence to be output in the
"Single" trigger mode.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:SLUNit on page 117

Signal Duration
Requires trigger "Mode" > "Single".
Enters the length of the trigger signal sequence.
Use this parameter, for example, for the following applications:
● To output the trigger signal partly.
● To output a predefined sequence of the trigger signal.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:SLENgth on page 116

Time Based Trigger
Requires trigger "Mode" > "Armed Auto"/"Single".
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Activates time-based triggering with a fixed time reference.
The R&S SMW triggers signal generation when its operating system time ("Current
Time") matches a specified time trigger ("Trigger Time"). As trigger source, you can
use an internal trigger or an external global trigger.
How to: Chapter "Time-based triggering" in the R&S SMW user manual.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:TIME[:STATe] on page 116

Trigger Time
Requires trigger "Mode" > "Armed Auto"/"Single".
Sets date and time for a time-based trigger signal.
Set a trigger time that is later than the "Current Time". The current time is the operating
system time of the R&S SMW. If you set an earlier trigger time than the current time,
time-based triggering is not possible.
How to: Chapter "Time-based triggering" in the R&S SMW user manual.

"Date" Sets the date of the time-based trigger in format YYYY-MM-DD.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:TIME:DATE on page 115

"Time" Sets the time of the time-based trigger in format hh:mm:ss.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:TIME:TIME on page 115

Running/Stopped
With enabled modulation, displays the status of signal generation for all trigger modes.
● "Running"

The signal is generated; a trigger was (internally or externally) initiated in triggered
mode.

● "Stopped"
The signal is not generated and the instrument waits for a trigger event.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:RMODe? on page 115

Arm
Stops the signal generation until subsequent trigger event occurs.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute on page 117

Execute Trigger
For internal trigger source, executes trigger manually.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute on page 117

Source
The following sources of the trigger signal are available:
● "Internal"

Trigger settings
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The trigger event is executed manually by the "Execute Trigger".
● "Internal (Baseband A/B)"

The trigger event is provided by the trigger signal from the other basebands.
If common trigger settings are applied, this trigger source is disabled.

● "External Global Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the USER x connectors.

● "External Local Trigger"
The trigger event is the active edge of an external trigger signal provided and con-
figured at the local T/M/C connector.
With coupled trigger settings, the signal has to be provided at the T/M/C1/2/3 con-
nectors.

● "External Local Clock"
The trigger event is the active edge of an external local clock signal provided and
configured at the local T/M/C connector.
With coupled trigger settings, the signal has to be provided at the T/M/C1 connec-
tor.

How to: "Routing and activating a trigger signal" on page 56
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:SOURce on page 114

Sync. Output to External Trigger/Sync. Output to Trigger
Enables signal output synchronous to the trigger event.
● "On"

Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the trigger event. Because of the
processing time of the instrument, the first samples are cut off and no signal is out-
put. After elapsing of the internal processing time, the output signal is synchronous
to the trigger event.

● "Off"
The signal output begins after elapsing of the processing time. Signal output starts
with sample 0. The complete signal is output.
This mode is recommended for triggering of short signal sequences. Short sequen-
ces are sequences with signal duration comparable with the processing time of the
instrument.

Trigger settings
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Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:EXTernal:SYNChronize:OUTPut
on page 117

External Inhibit/Trigger Inhibit
Applies for external trigger signal or trigger signal from the other path.
Sets the duration with that any following trigger event is suppressed. In "Retrigger"
mode, for example, a new trigger event does not cause a restart of the signal genera-
tion until the specified inhibit duration does not expire.
For more information, see chapter "Basics" in the R&S SMW user manual.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:INHibit on page 118
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:INHibit on page 118

External Delay/Trigger Delay
Delays the trigger event of the signal from:
● The external trigger source
● The other path
● The other basebands (internal trigger), if common trigger settings are used.
Use this setting to:
● Synchronize the instrument with the device under test (DUT) or other external devi-

ces
● Postpone the signal generation start in the basebands compared to each other
For more information, see chapter "Basics on ..." in the R&S SMW user manual.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:DELay on page 117
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:DELay on page 118

Trigger settings
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4.3  Marker settings

Access:

► Select "Baseband" > "GBAS" > "Marker".

This tab provides settings to select and configure the marker output signal includ-
ing marker mode and marker delay.

Routing and activating a marker signal

1. To define the signal shape of an individual marker signal "x", select "Marker" >
"Marker x" > "Mode".

2. Optionally, define the connector for signal output. See Chapter 4.5, "Local and
global connectors settings", on page 64.
You can map marker signals to one or more USER x or T/M connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMW adds the marker signal to the baseband signal. Also, R&S SMW
outputs this signal at the configured USER x connector.

About marker output signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMW user manual.

Settings:

Mode............................................................................................................................. 61
Delay............................................................................................................................. 62

Mode
Marker configuration for up to 3 markers. The settings are used to select the marker
mode defining the shape and periodicity of the markers. The contents of the dialog
change with the selected marker mode.
How to: "Routing and activating a marker signal" on page 61
"1PPS" Marker signal for every start of second.

Marker settings
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"Restart" The generated marker signal is a single "On" pulse. The rising edge
of this pulse is generated at the signal generation start as well as at
each subsequent signal restart time.
Use this marker mode to monitor the effects of the selected trigger,
e.g. trigger causing restarts of the signal generation.

"Pulse" Regular marker signal.
Enter a divider to define the clock frequency. The software derives the
frequency by dividing the sample rate by this divider; the dialog indi-
cates the resulting pulse frequency.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:
DIVider on page 120
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:
FREQuency? on page 120

"Pattern" Marker signal is a pattern with a length of maximum 64 bits.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PATTern
on page 119

"On/Off Ratio"
Regular marker signal defined by an On/Off ratio.
A marker period lasts one On and Off cycle. The "On time" and "Off
time" are each expressed as a number of samples.

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:ONTime
on page 119
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:OFFTime
on page 119

Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:MODE on page 119

Delay
Delays the marker signal at the marker output relative to the signal generation start.
Variation of the parameter "Marker x" > "Delay" causes signal recalculation.
Remote command: 
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay on page 119

Marker settings
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4.4  Clock settings

Access:

► Select "Baseband" > "GBAS" > "Clock".

This tab provides access to the settings necessary to select and configure the
clock signal, like the clock source and clock mode.

Defining the clock

1. Select "Clock" > "Source" to define the source of clock signal.

2. For external clock signals, define the connector for signal input. See Chapter 4.5,
"Local and global connectors settings", on page 64.
You can map clock signals to one or more USER x or T/M connectors.

Local and global connectors settings allow you to configure the signal mapping, the
polarity, the trigger threshold and the input impedance of the input connectors.

3. Activate baseband signal generation. In the block diagram, set "Baseband" > "On".

The R&S SMW starts baseband signal generation with a symbol rate that equals
the clock rate.

About clock signals

This section focuses on the available settings.

For information on how these settings affect the signal, refer to section "Basics on ..."
in the R&S SMW user manual.

Settings:

Clock Source.................................................................................................................63
Clock Mode................................................................................................................... 64
Measured External Clock.............................................................................................. 64

Clock Source
Selects the clock source.
● "Internal"

The instrument uses its internal clock reference.
● "External Local Clock"

Option: R&S SMW-B10
The instrument expects an external clock reference at the local T/M/C connector.

How to: "Defining the clock" on page 63
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Remote command: 
[:SOURce<hw>]:BB:GBAS:CLOCk:SOURce on page 121

Clock Mode
Sets the type of externally supplied clock.
Remote command: 
[:SOURce<hw>]:BB:GBAS:CLOCk:MODE on page 121

Measured External Clock
Provided for permanent monitoring of the enabled and externally supplied clock signal.
Remote command: 
CLOCk:INPut:FREQuency?

4.5  Local and global connectors settings

Accesses a dialog to configure local connectors or global connectors.

The button is available in the following dialogs or tabs:
● "Trigger / Marker / Clock" dialog that is accessible via the "TMC" block in the block

diagram.
● "Trigger In", "Marker" and "Clock" tabs that are accessible via the "Baseband"

block in the block diagram.

See also chapter "Local and global connectors settings" in the user manual.

Local and global connectors settings
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5  How to work with the GBAS option
Testing GBAS receivers can be a challenging task. The main error sources that influ-
ence the performance of a GBAS airborne device are typically caused by distortion on
the VHF link or mismatch in the application data. The former could be caused by inter-
ference, multipath effects and ground and/or surface reflections. The latter is usually
related to a bias in the differential corrections (message type 1 and 11) and/or mis-
match between the TAP/FAS data transmitted on the link and the actually wanted flight
path by the air traffic control (ATC) (message type 4).

The following step-by-step instructions demonstrate how to perform some signal gen-
eration tasks with the GBAS option and generate signals suitable for GBAS testing.
The following sections focus on the R&S SMW configuration. Necessary configuration
in VDB receivers, devices under test (DUT) or other test equipment are beyond the
scope of this description.

5.1  Loading differential GBAS data

Differential GNSS is an approach that uses known GNSS reference locations to deter-
mine channel correction parameters. The retrieved information is transmitted to other
GNSS receivers to increase the accuracy of their position information.

Access:

1. Select "Data Config > Message Config...", see Chapter 3.3, "Message configura-
tion settings", on page 24.

2. Select "VDB#:Message Configuration > Message Type 1 & 11", see Chapter 3.3.1,
"Message type 1 & 11 settings", on page 24

3. Enable "Message Type 1" or "Message Type 11".

This dialog comprises settings to manage GBAS differential data.

4. To load a file, select "Differential Corrections File".
In the "Proprietary File > Predefined Files" dialog, the Correction1.rs_gbas file
is selected per default.

5. Alternatively, select "Differential Corrections File" and load or user-defined file in
the "Proprietary File > User Files" dialog.
See Chapter A.2, "GBAS differential file format", on page 122 for description of the
required file format.

Loading differential GBAS data
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6  Remote-control commands
The following commands are required to perform signal generation with the GBAS
option in a remote environment. We assume that the R&S SMW has already been set
up for remote operation in a network as described in the R&S SMW documentation. A
knowledge about the remote control operation and the SCPI command syntax are
assumed.

Conventions used in SCPI command descriptions
For a description of the conventions used in the remote command descriptions, see
section "Remote Control Commands" in the R&S SMW user manual.

Common Suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1] to 4 available baseband signals

OUTPut<ch> 1 to 3 available markers

VDB<ch> 1 to 8 VDB transmitter

TS<st> 1 to 8 time slot

The following commands specific to the GBAS are described here:

● Programming examples.......................................................................................... 66
● General commands.................................................................................................72
● Transmitter commands........................................................................................... 75
● Scheduling commands............................................................................................79
● Message configuration commands......................................................................... 82
● Filter/clipping/modulation commands....................................................................110
● Trigger commands.................................................................................................113
● Marker commands.................................................................................................118
● Clock commands...................................................................................................121

6.1  Programming examples

This description provides simple programming examples. The purpose of the examples
is to present all commands for a given task. In real applications, one would rather
reduce the examples to an appropriate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the example
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

Programming examples
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At the beginning of the most remote control program, an instrument (p)reset is recom-
mended to set the instrument to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

Example: Configuring GBAS general settings
The following example provides information on GBAS general settings.

// Query GBAS mode and corresponding GBAS specification.
SOURce1:BB:GBAS:MODE?
// Response: "GBAS"
SOURce1:BB:GBAS:VERSion?
// Response: "RTCA DO-246D"
SOURce1:BB:GBAS:MODE SCAT
SOURce1:BB:GBAS:VERSion?
// Response: "RTCA DO-217"

// Save the current configuration.
SOURce1:BB:GBAS:SETTing:STORe "/var/user/my_gbas"
*RST
SOURce1:BB:GBAS:SETTing:CATalog?
// Response: "my_gbas"
SOURce1:BB:GBAS:SETTing:LOAD "/var/user/my_gbas"

SOURce1:BB:GBAS:STATe 1
SOURce1:BB:GBAS:SETTing:DELete "my_gbas"

Example: Generating a GBAS signal for sensitivity tests
The following example uses the gated power mode.

*RST
SOURce1:FREQuency:CW 108.4MHz
SOURce1:POWer:LEVel:IMMediate:AMPLitude  -10

SOURce1:BB:GBAS:GPOW ON
// Query the corresponding GBAS version.
SOURce1:BB:GBAS:VDB1:SCH:TS1:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS1:POWer 0
SOURce1:BB:GBAS:VDB1:SCH:TS3:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS3:POWer -15
SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON
// Reduce the relative power of TS3.
SOURce1:BB:GBAS:VDB1:SCH:TS3:POWer -45

Example: Generating a GBAS signal for VDB slot detection
The following is an example on how to configure transmission of two VDBs on a com-
mon carrier frequency of 100 MHz. VDB#1 and VDB#2 use different timeslots.

Programming examples
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*RST
SOURce1:FREQuency:CW 110MHz

SOURce1:BB:GBAS:VDB:APPend
SOURce1:BB:GBAS:VDB1:SCH:TS1:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS1:POWer 0
SOURce1:BB:GBAS:VDB1:SCH:TS8:STATe ON
SOURce1:BB:GBAS:VDB1:SCH:TS8:POWer 0
SOURce1:BB:GBAS:VDB2:SCH:TS2:STATe ON
SOURce1:BB:GBAS:VDB2:SCH:TS2:POWer 0
SOURce1:BB:GBAS:VDB2:SCH:TS5:STATe ON
SOURce1:BB:GBAS:VDB2:SCH:TS5:POWer 0
SOURce1:BB:GBAS:VDB2:SCH:TS7:STATe ON
SOURce1:BB:GBAS:VDB2:SCH:TS7:POWer 0

SOURce1:BB:GBAS:VDB2:STATe?
// Response: "1"
SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON
// Generate a waveform and save it in the default directory.
SOURce1:BB:GBAS:WAVeform:CREate "gbas_slot_detection"
// Save the settings in a file in the default directory.
SOURce1:BB:GBAS:SETTing:STORe "gbas_slot_detection"

Example: Generating a GBAS signal for message-format detection
The following is an example on how to generate a VDB signal with real application data
and enabled GBAS message type 2 and message type 1.

*RST
SOURce1:FREQuency:CW 110MHz

SOURce1:BB:GBAS:VDB1:DATA RGData
SOURce1:BB:GBAS:VDB1:MCONfig:MT2State ON
SOURce1:BB:GBAS:VDB1:MCONfig:GSRReceivers GW3R
SOURce1:BB:GBAS:VDB1:MCONfig:GSADesignator GADB
SOURce1:BB:GBAS:VDB1:MCONfig:GCID FC
SOURce1:BB:GBAS:VDB1:MCONfig:LMVariation 58
SOURce1:BB:GBAS:VDB1:MCONfig:SVIGradient 0
SOURce1:BB:GBAS:VDB1:MCONfig:RFINdex 379
SOURce1:BB:GBAS:VDB1:MCONfig:SHEight 100
SOURce1:BB:GBAS:VDB1:MCONfig:RUNCertainty 20
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:DECimal 11.5833, 48.150, 110
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:FORMat DMS
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:DMS?
// Response: "11,34,59.88,EAST,48,9,0,NORT,110"

SOURce1:BB:GBAS:VDB1:MCONfig:DG:STATe ON
SOURce1:BB:GBAS:VDB1:MCONfig:DG:PREDefined:CATalog?
// Response: "Correction1"
SOURce1:BB:GBAS:VDB1:MCONfig:DG:PREDefined:FILE "Correction1"
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SOURce1:BB:GBAS:VDB1:MCONfig:DG:FILE?
// Response: "Correction1.rs_gbas"

SOURce1:BB:GBAS:VDB1:SSID?
// Response: "A"
SOURce1:BB:GBAS:VDB1:GID?
// REsponse: "TR0"
SOURce1:BB:GBAS:VDB1:NOFRames?
// Response: "20"
SOURce1:BB:GBAS:VDB1:FNUMber?
// Response: "0"

SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON

SOURce1:BB:GBAS:SETTing:STORe "gbas_msg_fmt_detection"
SOURce1:BB:GBAS:SETTing:CATalog?
// Response: gbas_msg_fmt_detection,gbas_slot_detection

Example: Configuring GBAS message type 2 parameters
The following is an example on how to generate a VDB signal with real application data
and enabled GBAS Message Type 2.

SOURce1:BB:GBAS:VDB1:MCONfig:MT2State 0
SOURce1:BB:GBAS:VDB1:MCONfig:GSRReceivers GW2R
SOURce1:BB:GBAS:VDB1:MCONfig:GSADesignator GADA
SOURce1:BB:GBAS:VDB1:MCONfig:GCID FC
SOURce1:BB:GBAS:VDB1:MCONfig:LMVariation 0
SOURce1:BB:GBAS:VDB1:MCONfig:SVIGradient 0
SOURce1:BB:GBAS:VDB1:MCONfig:RFINdex 16
SOURce1:BB:GBAS:VDB1:MCONfig:SHEight 0
SOURce1:BB:GBAS:VDB1:MCONfig:RUNCertainty 0

// Configure additional data block 1.
SOURce1:BB:GBAS:VDB1:MCONfig:ADB1:STATe 1
SOURce1:BB:GBAS:VDB1:MCONfig:PSERvice:STATe 1
SOURce1:BB:GBAS:VDB1:MCONfig:RSDSelector 1
SOURce1:BB:GBAS:VDB1:MCONfig:MUDistance 2
SOURce1:BB:GBAS:VDB1:MCONfig:KPGPs 0
SOURce1:BB:GBAS:VDB1:MCONfig:KCGPs 0
SOURce1:BB:GBAS:VDB1:MCONfig:KPGLonass 0
SOURce1:BB:GBAS:VDB1:MCONfig:KCGLonass 0

// Configure additional data block 3.
SOURce1:BB:GBAS:VDB1:MCONfig:ADB3:STATe 1
SOURce1:BB:GBAS:VDB1:MCONfig:KDGPs 0
SOURce1:BB:GBAS:VDB1:MCONfig:KDGLonass 0
SOURce1:BB:GBAS:VDB1:MCONfig:SVID 0

// Configure additional data block 4.
SOURce1:BB:GBAS:VDB1:MCONfig:ADB4:STATe 1

Programming examples
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SOURce1:BB:GBAS:VDB1:MCONfig:SGDefinition:A:STATe 1
SOURce1:BB:GBAS:VDB1:MCONfig:SGDefinition:B:STATe 1
SOURce1:BB:GBAS:VDB1:MCONfig:SGDefinition:C:STATe 1

// Set the reference location.
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:DECimal 11.5833, 48.150, 110
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:FORMat DMS
SOURce1:BB:GBAS:VDB1:MCONfig:LOCation:COORdinates:DMS?
// Response: "11,34,59.88,EAST,48,9,0,NORT,11"
SOURce1:BB:GBAS:VDB1:MCONfig:MT2State 1

Example: Generating a GBAS signal containing message type 4
The following is an example on how to generate a VDB signal with real application data
and enabled GBAS message type 4.

*RST
SOURce1:FREQuency:CW 110MHz

SOURce1:BB:GBAS:VDB1:DATA RGData
SOURce1:BB:GBAS:VDB1:MCONfig:MT4State ON

SOURce1:BB:GBAS:VDB1:MCONfig:FDSState ON
SOURce1:BB:GBAS:VDB1:MCONfig:GPANgle 30
SOURce1:BB:GBAS:VDB1:MCONfig:ATUSelector MET
SOURce1:BB:GBAS:VDB1:MCONfig:ATCHeight 1200
SOURce1:BB:GBAS:VDB1:MCONfig:LFLocation:HEIGht 103
SOURce1:BB:GBAS:VDB1:MCONfig:AID KJFK
SOURce1:BB:GBAS:VDB1:MCONfig:RNUMber 13
SOURce1:BB:GBAS:VDB1:MCONfig:RLETter LETL
SOURce1:BB:GBAS:VDB1:MCONfig:APDesignator GC
SOURce1:BB:GBAS:VDB1:MCONfig:RUINdicator "A"
SOURce1:BB:GBAS:VDB1:MCONfig:RPDF 3
SOURce1:BB:GBAS:VDB1:MCONfig:RPIF "L13A"
SOURce1:BB:GBAS:VDB1:MCONfig:LFLocation:COORdinates:DECimal -0.012650,0.027897
SOURce1:BB:GBAS:VDB1:MCONfig:LFLocation:COORdinates:FORMat DMS
SOURce1:BB:GBAS:VDB1:MCONfig:LFLocation:COORdinates:DMS?
// Response: "73,47,13.83,EAST,40,39,22.95,NORT"
SOURce1:BB:GBAS:VDB1:MCONfig:DFLocation:COORdinates:DECimal -0.012650, 0.027897
SOURce1:BB:GBAS:VDB1:MCONfig:DFLocation:COORdinates:FORMat DMS
SOURce1:BB:GBAS:VDB1:MCONfig:DFLocation:COORdinates:DMS?
// Response: "0,0,45.54,WEST,0,1,40.429,NORT"
SOURce1:BB:GBAS:VDB1:MCONfig:CWAThreshold 105
SOURce1:BB:GBAS:VDB1:MCONfig:DLOFfset 0
SOURce1:BB:GBAS:VDB1:MCONfig:FVAA 0
SOURce1:BB:GBAS:VDB1:MCONfig:FLAA 40

SOURce1:BB:GBAS:VDB1:MCONfig:TDSState ON
SOURce1:BB:GBAS:VDB1:MCONfig:RPDT 21
SOURce1:BB:GBAS:VDB1:MCONfig:RPIT "GTN"
SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:PREDefined:CATalog?
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// Response: "Braunschweig"
SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:PREDefined:FILE "Braunschweig"
SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:FILE?
// Response: "Braunschweig.txt"
SOURce1:BB:GBAS:VDB1:MCONfig:NOPPoint?
// Response: "11"
Query user waypoint files in the default directory
SOURce1:BB:GBAS:VDB1:MCONfig:WAYPoint:USER:CATalog? 
// Response: "gbas_waypoint"
SOURce1:BB:GBAS:VDB1:MCONfig:FRCLink 3
SOURce1:BB:GBAS:VDB1:MCONfig:TVAS 50
SOURce1:BB:GBAS:VDB1:MCONfig:TLAS 2

SOURce1:BB:GBAS:STATe ON
OUTput1:STATe ON

Example: Adjusting clock, marker and trigger settings
The following example lists the provided commands:

// ******************************************************************
// Clock settings
// ******************************************************************
SOURce1:BB:GBAS:CLOCk:SOURce INTernal

// ******************************************************************
// Configure and enable standard marker signal
// ******************************************************************
SOURce1:BB:GBAS:TRIGger:OUTPut1:MODE RATio
SOURce1:BB:GBAS:TRIGger:OUTPut1:ONTime 40
SOURce1:BB:GBAS:TRIGger:OUTPut1:OFFTime 20

// ******************************************************************
// Configure and enable signal generation
// ******************************************************************
SOURce1:BB:GBAS:TRIGger:SOURce INTernal
SOURce1:BB:GBAS:TRIGger:SEQuence ARETrigger
SOURce1:BB:GBAS:STAT ON
SOURce1:BB:GBAS:TRIGger:EXECute
SOURce1:BB:GBAS:TRIGger:ARM:EXECute
SOURce1:BB:GBAS:TRIGger:RMODe?
// Stopped
SOURce1:BB:GBAS:TRIGger:EXECute
SOURce1:BB:GBAS:TRIGger:RMODe?
// Run

Example: Querying the default filter, clipping and modulation settings
The following is a general example on working with these settings.

Programming examples
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SOURce1:BB:GBAS:PRESet

SOURce1:BB:GBAS:SRINfo?
// Response: "10.5 kHz"
SOURce1:BB:GBAS:FILTer:TYPE?
// Response: COS
SOURce1:BB:GBAS:FILTer:PARameter:COSine?
// Response: 0.6
SOURce1:BB:GBAS:FILTer:PARameter:COSine:COFS?
// Response:0
SOURce1:BB:GBAS:MSET:MTYPe?
// Response: "D8PSK"
SOURce1:BB:GBAS:MSET:SRATe?
// Response: 10500

SOURce1:BB:GBAS:MSET:SRATe?
// Response: 525000
SOURce1:BB:GBAS:SRINfo?
// Response: "525 kHz"

SOURce1:BB:GBAS:CLIPping:STATe?
// Response: 0
SOURce1:BB:GBAS:CLIPping:LEVel?
// Response: 100
SOURce1:BB:GBAS:CLIPping:MODE?
// Response: VECTor

6.2  General commands

[:SOURce<hw>]:BB:GBAS:GPOW.....................................................................................72
[:SOURce<hw>]:BB:GBAS:MODE..................................................................................... 73
[:SOURce<hw>]:BB:GBAS:PRESet................................................................................... 73
[:SOURce<hw>]:BB:GBAS:SETTing:CATalog?....................................................................73
[:SOURce<hw>]:BB:GBAS:SETTing:DELete.......................................................................74
[:SOURce<hw>]:BB:GBAS:SETTing:LOAD.........................................................................74
[:SOURce<hw>]:BB:GBAS:SETTing:STORe.......................................................................74
[:SOURce<hw>]:BB:GBAS:STATe......................................................................................75
[:SOURce<hw>]:BB:GBAS:VERSion?................................................................................75
[:SOURce<hw>]:BB:GBAS:WAVeform:CREate................................................................... 75

[:SOURce<hw>]:BB:GBAS:GPOW <GPow>

Enables gated power mode.

Parameters:
<GPow> 1 | ON | 0 | OFF

*RST: 1

General commands
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Example: See Example"Generating a GBAS signal for sensitivity tests"
on page 67.

Manual operation: See "Gated Power Mode" on page 21

[:SOURce<hw>]:BB:GBAS:MODE <SCAT>

Sets the GBAS mode.

Select between GBAS (LAAS) header information or SCAT-I header information.

Parameters:
<SCAT> GBAS | SCAT

*RST: GBAS

Example: See Example"Configuring GBAS general settings" on page 67.

Manual operation: See "Mode" on page 21

[:SOURce<hw>]:BB:GBAS:PRESet

Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:BB:GBAS:STATe.

Example: See Example"Configuring GBAS general settings" on page 67.

Example: See Example"Generating a GBAS signal for sensitivity tests"
on page 67.

Usage: Event

Manual operation: See "Set to Default" on page 20

[:SOURce<hw>]:BB:GBAS:SETTing:CATalog?

Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.gbas.

Return values: 
<Catalog> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: See Example"Configuring GBAS general settings" on page 67.

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Usage: Query only

Manual operation: See "Save/Recall" on page 20

General commands
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[:SOURce<hw>]:BB:GBAS:SETTing:DELete <Filename>

Deletes the selected file from the default or the specified directory. Deleted are files
with extension *.gbas.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted

Example: See Example"Configuring GBAS general settings" on page 67.

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Usage: Setting only

Manual operation: See "Save/Recall" on page 20

[:SOURce<hw>]:BB:GBAS:SETTing:LOAD <Filename>

Loads the selected file from the default or the specified directory. Loaded are files with
extension *.gbas.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted.

Example: See Example"Configuring GBAS general settings" on page 67.

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Usage: Setting only

Manual operation: See "Save/Recall" on page 20

[:SOURce<hw>]:BB:GBAS:SETTing:STORe <Filename>

Saves the current settings into the selected file; the file extension (*.gbas) is
assigned automatically.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path

Example: See Example"Configuring GBAS general settings" on page 67.

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Usage: Setting only

Manual operation: See "Save/Recall" on page 20
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[:SOURce<hw>]:BB:GBAS:STATe <State>

Activates the standard and deactivates all the other digital standards and digital modu-
lation modes in the same path.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring GBAS general settings" on page 67.

Example: See Example"Generating a GBAS signal for sensitivity tests"
on page 67.

Manual operation: See "State" on page 19

[:SOURce<hw>]:BB:GBAS:VERSion?

Queries the GBAS specification version that corresponds to the set GBAS mode.

Return values: 
<Version> string

Example: See Example"Configuring GBAS general settings" on page 67.

Usage: Query only

[:SOURce<hw>]:BB:GBAS:WAVeform:CREate <Filename>

With enabled signal generation, triggers the instrument to save the current settings of
an arbitrary waveform signal in a waveform file with predefined extension *.wv. You
can define the filename and the directory, in that you want to save the file.

Using the ARB modulation source, you can play back waveform files and/or process
the file to generate multi-carrier or multi-segment signals.

Setting parameters: 
<Filename> string

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Usage: Setting only

Manual operation: See "Generate Waveform" on page 20

6.3  Transmitter commands

[:SOURce<hw>]:BB:GBAS:NOFRames?............................................................................76
[:SOURce<hw>]:BB:GBAS:VDB:APPend........................................................................... 76
[:SOURce<hw>]:BB:GBAS:VDB<ch>:INSert.......................................................................76
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DELete..................................................................... 76
[:SOURce<hw>]:BB:GBAS:VDB<ch>:STATe.......................................................................77
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:RID.......................................................................... 77
[:SOURce<hw>]:BB:GBAS:VDB<ch>:GID.......................................................................... 77
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SGID........................................................................ 77
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SSID.........................................................................77
[:SOURce<hw>]:BB:GBAS:VDB<ch>:FNUMber.................................................................. 77
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DLENgth...................................................................78
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA........................................................................78
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:DSELection......................................................78
[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:PATTern...........................................................79

[:SOURce<hw>]:BB:GBAS:NOFRames?

Queries the number of VDB frames.

Return values: 
<NOFrame> integer

Range: 1  to  12500
*RST: 1

Usage: Query only

Manual operation: See "Number of Frames" on page 24

[:SOURce<hw>]:BB:GBAS:VDB:APPend

Appends a new VDB to the end of the VDB list.

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Usage: Event

Manual operation: See "Append, Insert, Delete" on page 24

[:SOURce<hw>]:BB:GBAS:VDB<ch>:INSert

Inserts a new VDB before the selected one.

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Usage: Event

Manual operation: See "Append, Insert, Delete" on page 24

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DELete

Deletes the selected VDB.

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Usage: Event
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Manual operation: See "Append, Insert, Delete" on page 24

[:SOURce<hw>]:BB:GBAS:VDB<ch>:STATe <VState>

Enables the selected VHF Data Broadcast (VDB) transmiter.

Parameters:
<VState> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Manual operation: See "State" on page 22

[:SOURce<hw>]:BB:GBAS:VDB<ch>:RID <RId>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:GID <GId>
Sets the GBAS ID.

Parameters:
<GId> string

A four-character (24-bit) alphanumeric field that identifies the
ground station broadcasting the message.
Permitted are capital letter, numbers and "space".

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "GBAS ID" on page 22

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SGID <Sgid>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SSID <Ssid>
Sets the Station Slot Identifier SSID of the ground station.

Parameters:
<Ssid> A | B | C | D | E | F | G | H

*RST: A

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "SSID" on page 23

[:SOURce<hw>]:BB:GBAS:VDB<ch>:FNUMber <FNum>

Sets the frequency number that the corresponding VDB is using.
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Parameters:
<FNum> integer

Range: -5  to  5
*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "FN -5 to 5" on page 47

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DLENgth <DataLen>

Sets the application data length.

Parameters:
<DataLen> integer

Range: 1  to  65495
*RST: 222

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "App. Data Length/bytes" on page 23

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA <Data>

Selects the data source, e.g. a sequence of 0 or 1, a pseudo-random sequence with
different length, a pattern or a data list (DLISt).

Parameters:
<Data> ZERO | ONE | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 |

PN21 | PN23 | DLISt | RGData
*RST: PN9

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Data/Data Configuration" on page 23

[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:DSELection <DSelection>

Selects the data list for the data source.

Parameters:
<DSelection> string

Example: :SOURce1:BB:GBAS:VDB2:DATA DLISt
:SOURce1:BB:GBAS:VDB2:DATA:DSELection
"/var/user/gbas_dl.dm_iqd "

Manual operation: See "Data/Data Configuration" on page 23
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:DATA:PATTern <Pattern>, <BitCount>

Selects the bit pattern for the data source.

Parameters:
<Pattern> numeric

*RST: #H0

<BitCount> integer
Range: 1  to  64
*RST: 1

Example: :SOURce1:BB:GBAS:VDB2:DATA PATTern
:SOURce1:BB:GBAS:VDB2:DATA:PATTern #HB8A,12

Manual operation: See "Data/Data Configuration" on page 23

6.4  Scheduling commands

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:STATe....................................................79
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:POWer.................................................. 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:LPAir:STATe..............................................80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:LPAir:STATe............................................... 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:FOFFset?................................................. 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:FOFFset?...................................................80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:FOFFset.....................................................80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:FOFFset.....................................................80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:MBYTes?..................................................80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:MBYTes?................................................... 80
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:MBYTes?................................................... 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:MBYTes?................................................... 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:RFRame?.................................................81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:RFRame?...................................................81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:RFRame.................................................... 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:RFRame.................................................... 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:SLOT<di>:STATe.......................................81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:SLOT<di>:STATe........................................ 81
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:SLOT<di>:STATe........................................ 82
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:SLOT<di>:STATe........................................ 82

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:STATe <State>

Enables the VDB in the corresponding time slot (TS).

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.
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Manual operation: See "State" on page 49

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:TS<st>:POWer <Power>

Sets the relative power of a VDB per time slot (TS).

Parameters:
<Power> float

Range: -21  to  0
Increment: 0.01
*RST: 0

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Manual operation: See "Power Offset" on page 49

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:LPAir:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:LPAir:STATe <State>
If enabled, the set of measurement blocks is included in a linked pair of messages
instead in a single message.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Manual operation: See "Link Pair" on page 50

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:FOFFset?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:FOFFset?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:FOFFset <Offset>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:FOFFset <Offset>
Sets the offset frame related to the first frame.

Parameters:
<Offset> integer

Range: 0  to  19
*RST: 0

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Manual operation: See "Frame Offset" on page 50

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:MBYTes?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:MBYTes?
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:MBYTes?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:MBYTes?
Sets the total number of bytes per message type.

Return values: 
<Bytes> integer

Range: 0  to  5000
*RST: 0

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Usage: Query only

Manual operation: See "Max Bytes per Slot" on page 50

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:RFRame?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:RFRame?
Queries the repetition rate for the respective message type.

Return values: 
<RepFrame> integer

Range: 1  to  20
*RST: 1

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Usage: Query only

Manual operation: See "Frame Cycle" on page 50

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:RFRame <RepFrame>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:RFRame <RepFrame>
Sets the repetition rate for the respective message type.

Parameters:
<RepFrame> integer

Range: 1  to  20
*RST: 1

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Manual operation: See "Frame Cycle" on page 50

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M11T:SLOT<di>:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M1T:SLOT<di>:STATe <State>

Scheduling commands



Remote-control commandsR&S®SMW-K111

82User Manual 1178.9690.02 ─ 09

[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M2T:SLOT<di>:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:SCH:M4T:SLOT<di>:STATe <State>
Enables the slot for the respective message type.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal for VDB slot detection"
on page 67.

Manual operation: See "Slot" on page 50

6.5  Message configuration commands

6.5.1  Message type 1 and 11 commands

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:M11State.............................................. 82
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:M1STate............................................... 82
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:STATe...................................................83
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:FILE................................. 83
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SUSer:FILE...........................................83
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:CATalog............................ 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SUSer:CATalog......................................84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:CATalog?............................84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:CATalog?.................................... 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:FILE...................................84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:FILE........................................... 84
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:FILE?................................................... 85
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SFILe?..................................................85

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:M11State <State>

Enables the use of the message type 11, C/A-Code L1, L2 delta corrections.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Message Type 11" on page 25

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:M1STate <State>

Enables the use of the message type 1, differential GPS corrections.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Message Type 1" on page 25

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:STATe <DiffGnssState>

Enables the use of differential GNSS data.

Parameters:
<DiffGnssState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:FILE <Filename>

Loads the selected predefined file (extension *.rs_scat).

Setting parameters: 
<Filename> string

Only the file name is required

Usage: Setting only

Manual operation: See "Predefined Files" on page 26

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SUSer:FILE <Filename>

Loads the selected user-defined file (extension *.rs_scat).

Per default, the instrument saves user-defined files in the /var/user/ directory. Use
the command :MMEM:CDIRectory to change the default directory to the currently
used one.

Setting parameters: 
<Filename> string

For files saved in the default directory, only the file name is
required.

Example: :SOURce1:BB:GBAS:VDB3:MCONfig:DG:SUSER:CATalog?
Response: scat_correction
:SOURce1:BB:GBAS:VDB3:MCONfig:DG:SUSER:FILE
"scat_correction"

Usage: Setting only

Manual operation: See "Differential Corrections File ..." on page 25
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SPRedefined:CATalog
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SUSer:CATalog
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:CATalog?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:CATalog?
Queries the names of the existing user defined/predefined GBAS/SCAT-I differential
files.

Per default, the instrument saves user-defined files in the /var/user/ directory. Use
the command :MMEM:CDIRectory to change the default directory to the currently
used one.

For GBAS differential files, files with extension *.rs_gbas are listed.

For SCAT-I differential files, files with extension *.rs_scat are listed.

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Usage: Query only

Manual operation: See "Differential Corrections File ..." on page 25

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:PREDefined:FILE <Filename>

Loads the selected predefined file (extension *.rs_gbas).

Setting parameters: 
<Filename> string

Only the file name is required

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Usage: Setting only

Manual operation: See "Predefined Files" on page 26

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:USER:FILE <Filename>

Loads the selected user-defined file (extension *.rs_gbas).

Per default, the instrument saves user-defined files in the /var/user/ directory. Use
the command :MMEM:CDIRectory to change the default directory to the currently
used one.

Setting parameters: 
<Filename> string

For files saved in the default directory, only the file name is
required.

Example: :SOURce1:BB:GBAS:VDB3:MCONfig:DG:USER:CATalog?
Response: gbas_correction
:SOURce1:BB:GBAS:VDB3:MCONfig:DG:USER:FILE
"gbas_correction"
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Usage: Setting only

Manual operation: See "Differential Corrections File ..." on page 25

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:FILE?

Queries the currently selected GBAS differential file.

Return values: 
<Filename> string

Filename with file extension (*.rs_gbas)

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Usage: Query only

Manual operation: See "Differential Corrections File ..." on page 25

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DG:SFILe?

Queries the currently selected SCAT-I differential file.

Return values: 
<Filename> string

Filename with file extension (*.rs_scat)

Example: :SOURce1:BB:GBAS:VDB1:MCONfig:DG:SFILe?
"Correction1.rs_scat"

Usage: Query only

Manual operation: See "Differential Corrections File ..." on page 25

6.5.2  Message type 2 commands

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT2State....................................................86
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB1:STATe............................................... 86
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB3:STATe............................................... 86
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB4:STATe............................................... 87
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GCID..........................................................87
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSADesignator........................................... 87
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSRReceivers............................................ 87
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LMVariation.................................................88
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RFINdex..................................................... 88
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUNCertainty..............................................88
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SHEight......................................................89
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVIGradient................................................ 89
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KCGLonass................................................ 89
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KCGPs....................................................... 89
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KPGLonass.................................................90
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KPGPs....................................................... 90
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MUDistance................................................ 90
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:PSERvice:STATe......................................... 90
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RSDSelector............................................... 90
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KDGLonass................................................ 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KDGPs....................................................... 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVID.......................................................... 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:A:STATe.................................. 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:B:STATe.................................. 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:C:STATe.................................. 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:D:STATe.................................. 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:E:STATe.................................. 91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:F:STATe...................................91
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:G:STATe.................................. 92
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:H:STATe.................................. 92
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DECimal................. 92
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DMS....................... 92
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:FORMat..................93

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT2State <Mt2State>

Enables the message type 2 configuration.

Parameters:
<Mt2State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Message Type 2" on page 27

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB1:STATe <State>

Enables the additional data block 1.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Additional Data Block 1" on page 30

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB3:STATe <State>

Enables the additional data block 3.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Additional Data Block 3" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ADB4:STATe <State>

Enables the additional data block.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Additional Data Block 4" on page 33

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GCID <Gcid>

Sets the ground station continuity/integrity designator.

Parameters:
<Gcid> FC | FD

*RST: FC

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "GS Continuity/Integrity Designator" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSADesignator <Gsad>

Sets the ground station accuracy designator.

Parameters:
<Gsad> GADA | GADB | GADC

*RST: GADA

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Ground Station Accuracy Designator" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GSRReceivers <Gsrr>

Sets the number of ground station reference receivers.

Parameters:
<Gsrr> GW3R | GW4R | GW2R

*RST: GW2R
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Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Ground Station Reference Receivers" on page 27

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LMVariation <Lmv>

Sets the local magnetic variation.

Parameters:
<Lmv> float

A positive value represents an east variation (clockwise from
true north)
Range: -180  to  180
Increment: 0.01
*RST: 0
Default unit: deg

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Local Magnetic Variation" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RFINdex <RefIdx>

Sets the refractivity index.

Parameters:
<RefIdx> integer

Range: 16  to  781
*RST: 16

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Refractivity Index" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUNCertainty <Runc>

Set the refractivity uncertainty.

Parameters:
<Runc> integer

Range: 0  to  255
*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Refractivity Uncertainty" on page 28
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SHEight <SHeight>

Sets the scale height.

Parameters:
<SHeight> float

Range: 0  to  25500
Increment: 100
*RST: 0
Default unit: m

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Scale Height" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVIGradient <Svig>

Sets the Sigma_vert_iono_gradient.

Parameters:
<Svig> float

Range: 0  to  2.55E-05
Increment: 0.1E-6
*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Sigma_vert_iono_gradient" on page 28

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KCGLonass <KmdECGlonass>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KCGPs <KmdECGps>
Sets the ephemeris missed detection parameter (Kmd_e), category I precision
approach and approach with vertical guidance (APV). This is a multiplier considered
when calculating the ephemeris error position bound for the category I precision
approach and APV. It is derived from the probability that a detection is missed because
of an ephemeris error in a GPS/GLONASS satellite.

Parameters:
<KmdECGps> float

Range: 0  to  12.75
Increment: 0.05
*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Kmd_e_C,GPS/Kmd_e_C,GLONASS" on page 31
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KPGLonass <KmdEPosGlonass>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KPGPs <KmdEPosGps>
Sets the ephemeris missed detection parameter (Kmd_e), GBAS positioning service .
This is a multiplier considered when calculating the ephemeris error position bound for
the GBAS positioning. It is derived from the probability that a detection is missed
because of an ephemeris error in a GPS/GLONASS satellite.

Parameters:
<KmdEPosGps> float

Range: 0  to  12.75
Increment: 0.05
*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Kmd_e_POS,GPS/Kmd_e_POS,GLONASS" on page 31

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MUDistance <Distance>

Sets the maximum distance from the reference point for which the integrity is assured.

Parameters:
<Distance> float

Range: 0  to  510
Increment: 2
*RST: 2

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Maximum User Distance" on page 31

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:PSERvice:STATe <State>

Selects if the GBAS positioning service is supported.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Positioning Service" on page 31

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RSDSelector <Rsds>

Sets the numerical identifier for selecting the ground subsystem.
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Parameters:
<Rsds> integer

Range: 0  to  48
*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Reference Station Data Selector" on page 31

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KDGLonass <KmdEDGlonass>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:KDGPs <KmdEDGps>
Sets the ephemeris missed detection parameter (Kmd_e), GAST D. This is a multiplier
considered when calculating the ephemeris error position bound for GAST D. It is
derived from the probability that a detection is missed because of an ephemeris error
in a GPS/GLONASS satellite.

Parameters:
<KmdEDGps> float

Range: 0  to  12.75
Increment: 0.05
*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Kmd_e_D,GPS/Kmd_e_D,GLONASS" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SVID <Svid>

Sets the standard deviation of a normal distribution connected to the residual iono-
spheric uncertainty which is caused by spatial decorrelation.

Parameters:
<Svid> float

Range: 0  to  2.55e-05
Increment: 0.1e-6
*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Sigma_vert_iono_gradient_D" on page 32

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:A:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:B:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:C:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:D:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:E:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:F:STATe <State>
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:G:STATe <State>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:SGDefinition:H:STATe <State>
If enabled, the specified slot is assigned for use by the ground station.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Configuring GBAS message type 2 parameters"
on page 69.

Manual operation: See "Slot Group Definition" on page 33

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DECimal
<Longitude>, <Latitude>, <Altitude>

Defines the coordinates of the ground station reference location in decimal format.

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0

<Altitude> float
Range: -83886.07  to  83886.07
Increment: 0.01
*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Reference Location Configuration" on page 29

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>, <Altitude>

Defines the coordinates of the ground station reference location in degrees, minutes
and seconds.

Parameters:
<LongitudeDeg> integer

Range: 0  to  180
*RST: 0
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<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

<Altitude> float
Defines the height above the ellipsoid (HAE) altitude.
Range: -83886.07  to  83886.07
Increment: 0.01
*RST: 0

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Reference Location Configuration" on page 29

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LOCation:COORdinates:FORMat
<Format>

Sets the format in which the latitude and longitude are set.
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Parameters:
<Format> DMS | DECimal

*RST: DMS

Example: See Example"Generating a GBAS signal for message-format
detection" on page 68.

Manual operation: See "Reference Location Configuration" on page 29

6.5.3  Message type 4 commands

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT4State....................................................95
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDSState....................................................95
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:AID...............................................95
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:AID............................................................ 95
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:APDesignator..............................................96
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:ATCHeight.....................................96
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATCHeight.................................................. 96
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATUSelector................................................96
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:CWAThreshold............................................ 97
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:DECimal...............97
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:DMS.................... 97
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:FORMat............... 98
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DLOFfset.................................................... 99
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:COORdinates:

DECimal............................................................................................................... 99
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:COORdinates:DMS...... 99
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:COORdinates:

FORMat..............................................................................................................100
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:COORdinates:

DECimal............................................................................................................. 101
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:COORdinates:DMS.... 101
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:COORdinates:

FORMat..............................................................................................................102
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FLAA........................................................102
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FVAA........................................................102
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:GPANgle.....................................103
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GPANgle...................................................103
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:DECimal............. 103
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:DMS...................104
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:FORMat..............105
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:HEIGht.................................... 105
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:NFDBlocks................................................105
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RLETter...................................... 105
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RLETter....................................................105
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RNUMber....................................106
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RNUMber................................................. 106
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RPDF......................................... 106
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDF....................................................... 106
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RPIF...........................................106
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIF........................................................ 106
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RUINdicator.................................106
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUINdicator.............................................. 106
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TDSState..................................................107
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FRCLink................................................... 107
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:NOPPoint................................................. 107
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDT....................................................... 108
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIT........................................................ 108
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TLAS........................................................108
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TVAS........................................................108
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:CATalog?................ 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:CATalog?.........................109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:FILE....................... 109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:FILE................................109
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:FILE?........................................ 110

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:MT4State <Mt4State>

Enables the configuration of message type 4.

Parameters:
<Mt4State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Message Type 4" on page 35

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDSState <Fdss>

Enables the configuration of Final Approach Segment (FAS) data set.

Parameters:
<Fdss> 1 | ON | 0 | OFF

*RST: 1

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "FAS Data Set" on page 36

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:AID <AId>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:AID <AId>
Sets the airport ID.

Parameters:
<AId> string

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.
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Manual operation: See "Airport ID" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:APDesignator <ApPerDes>

Requires "Mode > GBAS" (LAAS) header information.

Sets the approach performance designator.

Parameters:
<ApPerDes> GAB | GC | GCD

*RST: GAB

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Approach Performance Designator" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:ATCHeight <Tch>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATCHeight <Tch>
Requires "Mode > GBAS" (LAAS) header information.

Sets the approach threshold crossing height.

Parameters:
<Tch> float

Range: 0  to  1638.35
Increment: 0.05
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Plan View/Profile View Parameters" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:ATUSelector <TchUnit>

Requires "Mode > GBAS" (LAAS) header information.

Sets the units for the approach TCH, see [:SOURce<hw>]:BB:GBAS:VDB<ch>:
MCONfig:ATCHeight.

Parameters:
<TchUnit> FEET | MET

*RST: FEET

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Plan View/Profile View Parameters" on page 37
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:CWAThreshold <CrWdAtTh>

Requires "Mode > GBAS" (LAAS) header information.

Sets the course width at threshold.

Parameters:
<CrWdAtTh> float

Range: 80  to  143.75
Increment: 0.01
*RST: 80

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Course Width at Threshold" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:
DECimal <Longitude>, <Latitude>

Defines the coordinates of the Delta FPAD location in decimal format.

Parameters:
<Longitude> float

Range: -1.0  to  1.0
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -1.0  to  1.0
Increment: 1E-6
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Delta_FPAP Location Configuration" on page 43

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>

Defines the coordinates of the Delta FPAD location in degrees, minutes and seconds.

Parameters:
<LongitudeDeg> integer

Range: 0  to  1.0
*RST: 0
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<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  1.0
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Delta_FPAP Location Configuration" on page 43

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DFLocation:COORdinates:
FORMat <Format>

Sets the format in which the latitude and longitude are set.

Parameters:
<Format> DMS | DECimal

*RST: DMS

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.
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Manual operation: See "Delta_FPAP Location Configuration" on page 43

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:DLOFfset <DelLenOff>

Requires "Mode > GBAS" (LAAS) header information.

Sets the delta length offset.

Parameters:
<DelLenOff> float

Range: 0  to  2032
Increment: 8
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Delta_Length Offset" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:
COORdinates:DECimal <Longitude>, <Latitude>

Defines the coordinates of the Delta DERP location in decimal format.

Parameters:
<Longitude> string

Range: -0.182045  to  0.182045
Increment: 1E-6
*RST: 0

<Latitude> string
Range: -0.091023  to  0.091023
Increment: 1E-6
*RST: 0

Example: :SOURce1:BB:GBAS:VDB1:MCON:FDB1:DDL:COOR:
DECimal -0.012652,0.027897
:SOURce1:BB:GBAS:VDB1:MCON:FDB1:DDL:COOR:FORMat
DMS
:SOURce1:BB:GBAS:VDB1:MCON:FDB1:DDL:COOR:DMS?
// Response: 0,0,45.547,WEST,0,1,40.429,NORT

Manual operation: See "Delta_DERP Location Configuration" on page 45

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:
COORdinates:DMS <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>,
<LongitudeDir>, <LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>

Defines the coordinates of the Delta DERP location in degrees, minutes and seconds.
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Parameters:
<LongitudeDeg> integer

Range: 0  to  0
*RST: 0

<LongitudeMin> integer
Range: 0  to  10
*RST: 0

<LongitudeSec> float
Range: 0  to  55.358
Increment: 0.001
*RST: 0

<LongitudeDir> select
*RST: EAST

<LatitudeDeg> integer
Range: 0  to  0
*RST: 0

<LatitudeMin> integer
Range: 0  to  5
*RST: 0

<LatitudeSec> float
Range: 0  to  27.679
Increment: 0.001
*RST: 0

<LatitudeDir> select
*RST: NORT

Example: See [:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:
FDB<st>:DDLocation:COORdinates:DECimal on page 99.

Manual operation: See "Delta_DERP Location Configuration" on page 45

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DDLocation:
COORdinates:FORMat <Format>

Sets the format in which the latitude and longitude are set.

Parameters:
<Format> DMS | DECimal

*RST: DMS

Example: See [:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:
FDB<st>:DDLocation:COORdinates:DECimal on page 99.

Manual operation: See "Delta_DERP Location Configuration" on page 45
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:
COORdinates:DECimal <Longitude>, <Latitude>

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0

Example: :SOURce1:BB:GBAS:VDB1:MCON:FDB1:DPL:COOR:
DECimal -0.012652,0.027897
:SOURce1:BB:GBAS:VDB1:MCON:FDB1:DPL:COOR:FORMat
DMS
:SOURce1:BB:GBAS:VDB1:MCON:FDB1:DPL:COOR:DMS?
// Response: 0,0,45.547,WEST,0,1,40.429,NORT

Manual operation: See "DP Location Configuration" on page 44

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:
COORdinates:DMS <LongitudeDeg>, <LongitudeMin>, <LongitudeSec>,
<LongitudeDir>, <LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>

Parameters:
<LongitudeDeg> integer

Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> select
*RST: EAST

<LatitudeDeg> integer
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Range: 0  to  59
*RST: 0
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<LatitudeSec> float
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> select
*RST: NORT

Example: See [:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:
FDB<st>:DPLocation:COORdinates:DECimal
on page 101.

Manual operation: See "DP Location Configuration" on page 44

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:DPLocation:
COORdinates:FORMat <Format>

Sets the format in which the latitude and longitude are set.

Parameters:
<Format> DMS | DECimal

*RST: DMS

Example: See [:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:
FDB<st>:DPLocation:COORdinates:DECimal
on page 101.

Manual operation: See "DP Location Configuration" on page 44

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FLAA <FasVt>

Requires "Mode > GBAS" (LAAS) header information.

Sets the value of the broadcast lateral alert limit.

Parameters:
<FasVt> float

Range: 0  to  50.8
Increment: 0.2
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "FAS Lateral Alert Limit / Approach Status" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FVAA <Fvaa>

Requires "Mode > GBAS" (LAAS) header information.

Sets the value of the broadcast vertical alert limit.

Message configuration commands



Remote-control commandsR&S®SMW-K111

103User Manual 1178.9690.02 ─ 09

Parameters:
<Fvaa> float

Range: 0  to  25.4
Increment: 0.1
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "FAS Vertical Alert Limit / Approach Status" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:GPANgle <Gpa>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:GPANgle <Gpa>
Sets the glide path angle.

Parameters:
<Gpa> float

Range: 0  to  90
Increment: 0.01
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Plan View/Profile View Parameters" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:
DECimal <Longitude>, <Latitude>

Defines the coordinates of the LTP/FTP in decimal format.

Parameters:
<Longitude> float

Range: -180  to  180
Increment: 1E-6
*RST: 0

<Latitude> float
Range: -90  to  90
Increment: 1E-6
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "LTP/FTP Location Configuration" on page 43
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:DMS
<LongitudeDeg>, <LongitudeMin>, <LongitudeSec>, <LongitudeDir>,
<LatitudeDeg>, <LatitudeMin>, <LatitudeSec>, <LatitudeDir>

Defines the coordinates of the LTP/FTP in degrees, minutes and seconds.

Parameters:
<LongitudeDeg> integer

Range: 0  to  180
*RST: 0

<LongitudeMin> integer
Defines the longitude minutes.
Range: 0  to  59
*RST: 0

<LongitudeSec> float
Defines the longitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LongitudeDir> EAST | WEST
Defines the longitude direction.
*RST: EAST

<LatitudeDeg> integer
Defines the latitude degrees.
Range: 0  to  90
*RST: 0

<LatitudeMin> integer
Defines the latitude minutes.
Range: 0  to  59
*RST: 0

<LatitudeSec> float
Defines the latitude seconds.
Range: 0  to  59.999
Increment: 0.001
*RST: 0

<LatitudeDir> NORTh | SOUTh
Defines the latitude direction.
*RST: NORT

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "LTP/FTP Location Configuration" on page 43
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[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:COORdinates:
FORMat <Format>

Sets the format in which the latitude and longitude are set.

Parameters:
<Format> DMS | DECimal

*RST: DMS

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "LTP/FTP Location Configuration" on page 43

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:LFLocation:HEIGht <LfHeight>

Requires "Mode > GBAS" (LAAS) header information.

Sets the LTP/FTP height.

Parameters:
<LfHeight> float

Range: -512  to  6041.5
Increment: 0.1
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Plan View/Profile View Parameters" on page 37

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:NFDBlocks <Nfdb>

Requires "Mode > SCAT-I" header information.

Sets the number of FAS data blocks.

Parameters:
<Nfdb> integer

Range: 1  to  5
*RST: 1

Example: :SOURce1:BB:GBAS:VDB1:MCONfig:NFDBlocks 1
Sets 1 FAS data block.

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RLETter <Rlet>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RLETter <Rlet>
Sets the runway letter.

Parameters:
<Rlet> NLETter | LETR | LETL | LETC

*RST: NLETter
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Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Runway Letter" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RNUMber <Rnum>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RNUMber <Rnum>
Sets the runway number.

Parameters:
<Rnum> integer

Range: 1  to  36
*RST: 1

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Runway Number" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RPDF <Rpdf>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDF <Rpdf>
Sets the reference path data selector for FAS.

Parameters:
<Rpdf> integer

Range: 0  to  48
*RST: 1

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Reference Path Data Selector" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RPIF <Rpif>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIF <Rpif>
Sets the reference path identifier for FAS.

Parameters:
<Rpif> string

Three or four alphanumeric characters

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Reference Path ID" on page 39

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FDB<st>:RUINdicator <Ruin>
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RUINdicator <Ruin>
Sets the route indicator.
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Parameters:
<Ruin> a single upper case alphabetic character

Allowed are letters, excluding “I” and “O”, or the “space” charac-
ter.

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Route Indicator" on page 38

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TDSState <Tdss>

Requires "Mode > GBAS" (LAAS) header information.

Enables the configuration of the Terminal Area Path (TAP) data set.

Parameters:
<Tdss> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "TAP Data Set" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:FRCLink <Rpcl>

Requires "Mode > GBAS" (LAAS) header information.

Sets the FAS RPDS or continuation link.

Parameters:
<Rpcl> integer

Range: 0  to  255
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "FAS RPDS or Continuation Link" on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:NOPPoint <Nofp>

Requires "Mode > GBAS" (LAAS) header information.

Queries the number of path points - N.

Parameters:
<Nofp> integer

Range: 2  to  11
*RST: 2

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.
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Manual operation: See "Number of Path Points - N" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPDT <Rpdt>

Requires "Mode > GBAS" (LAAS) header information.

Sets the reference path data selector.

Parameters:
<Rpdt> integer

Range: 0  to  254
*RST: 1

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Reference Path Data Selector" on page 40

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:RPIT <Rpit>

Requires "Mode > GBAS" (LAAS) header information.

Sets the reference path identifier for TAP.

Parameters:
<Rpit> string

Three or four alphanumeric characters

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "Reference Path ID" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TLAS <Tlas>

Requires "Mode > GBAS" (LAAS) header information.

Sets the value of the broadcast lateral alert limit.

Parameters:
<Tlas> float

Range: 0  to  2.54
Increment: 0.01
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "TAP Lateral Alert Limit / Status" on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:TVAS <Tvas>

Requires "Mode > GBAS" (LAAS) header information.
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Sets the value of the broadcast vertical alert limit.

Parameters:
<Tvas> float

Range: 0  to  127
Increment: 0.5
*RST: 0

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Manual operation: See "TAP Vertical Alert Limit / Status" on page 42

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:CATalog?
[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:CATalog?
Requires "Mode > GBAS" (LAAS) header information.

Queries the names of the existing user defined/predefined waypoint files.

Per default, the instrument saves user-defined files in the /var/user/ directory. Use
the command :MMEM:CDIRectory to change the default directory to the currently
used one.

Only files with extension *.txt are listed.

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Usage: Query only

Manual operation: See "Waypoint File" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:PREDefined:FILE
<WpFile>

Requires "Mode > GBAS" (LAAS) header information.

Loads the selected predefined file (extension *.txt).

Setting parameters: 
<WpFile> string

Only the file name is required

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Usage: Setting only

Manual operation: See "Predefined Files" on page 26
See "Waypoint File" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:USER:FILE <Filename>

Requires "Mode > GBAS" (LAAS) header information.
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Loads the selected user-defined file (extension *.txt).

Per default, the instrument saves user-defined files in the /var/user/ directory. Use
the command :MMEM:CDIRectory to change the default directory to the currently
used one.

Setting parameters: 
<Filename> string

For files saved in the default directory, only the file name is
required.

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Usage: Setting only

Manual operation: See "Waypoint File" on page 41

[:SOURce<hw>]:BB:GBAS:VDB<ch>:MCONfig:WAYPoint:FILE?

Requires "Mode > GBAS" (LAAS) header information.

Queries the currently selected waypoint file.

Return values: 
<Filename> string

Filename with file extension (*.txt)

Example: See Example"Generating a GBAS signal containing message
type 4" on page 70.

Usage: Query only

Manual operation: See "Waypoint File" on page 41

6.6  Filter/clipping/modulation commands

[:SOURce<hw>]:BB:GBAS:CLIPping:STATe......................................................................111
[:SOURce<hw>]:BB:GBAS:CLIPping:LEVel.......................................................................111
[:SOURce<hw>]:BB:GBAS:CLIPping:MODE..................................................................... 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:APCO25..................................................... 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine.......................................................111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine:COFS.............................................111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:GAUSs....................................................... 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASs........................................................ 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASSEVM.................................................111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:PGAuss...................................................... 111
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:RCOSine.................................................... 112
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:SPHase......................................................112
[:SOURce<hw>]:BB:GBAS:FILTer:TYPE...........................................................................112
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[:SOURce<hw>]:BB:GBAS:MSET:MTYPe?.......................................................................112
[:SOURce<hw>]:BB:GBAS:MSET:SRATe?........................................................................113
[:SOURce<hw>]:BB:GBAS:SRINfo?.................................................................................113

[:SOURce<hw>]:BB:GBAS:CLIPping:STATe <State>

Enables/disable clipping.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Manual operation: See "State" on page 55

[:SOURce<hw>]:BB:GBAS:CLIPping:LEVel <Level>

Sets the limit for clipping.

Parameters:
<Level> integer

Range: 1  to  100
*RST: 100

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Manual operation: See "Clipping Level" on page 55

[:SOURce<hw>]:BB:GBAS:CLIPping:MODE <Mode>

Sets the clipping mode.

Parameters:
<Mode> VECTor | SCALar

*RST: VECTor

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Manual operation: See "Clipping Mode" on page 55

[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:APCO25 <Apco25>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine <Cosine>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:COSine:COFS <CoFs>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:GAUSs <Gauss>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASs <LPass>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:LPASSEVM <LPassevm>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:PGAuss <PGauss>
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[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:RCOSine <RCosine>
[:SOURce<hw>]:BB:GBAS:FILTer:PARameter:SPHase <SPhase>
Sets the corresponding filter parameter.

Filter Type Parameter Parameter Name min max increment default

APCO25 roll-off factor <Apco25> 0.05 0.99 0.01 0.2

COSine roll-off factor <Cosine> 0.05 1.00 0.01 0.35

COSine bandwidth to symbol rate ratio <CoFs> -2 2 0.01 1.00

GAUSs roll-off factor <Gauss> 0.15 2.5 0.01 0.3

LPASs cut off frequency <LPass> 0.05 2 0.01 0.5

LPASSEVM cut off frequency <LPassEvm> 0.05 2 0.01 0.5

PGAuss roll-off factor <PGauss> 0.15 2.5 0.01 0.3

RCOSine roll-off factor <RCosine> 0.05 1.00 0.01 0.35

SPHase B x T <SPhase> 0.15 2.5 0.01 2

Parameters:
<SPhase> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 2

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Manual operation: See "Rolloff Factor or BxT" on page 53

[:SOURce<hw>]:BB:GBAS:FILTer:TYPE <Type>

The command selects the filter type.

Parameters:
<Type> RCOSine | COSine | GAUSs | LGAuss | CONE | COF705 |

COEQualizer | COFequalizer | C2K3x | APCO25 | SPHase |
RECTangle | PGAuss | LPASs | DIRac | ENPShape |
EWPShape | LPASSEVM
*RST: COSine

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Manual operation: See "Filter" on page 53

[:SOURce<hw>]:BB:GBAS:MSET:MTYPe?

Queries the used modulation.

Filter/clipping/modulation commands
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Return values: 
<MType> string

*RST: D8PSK

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Usage: Query only

Manual operation: See "Modulation Type" on page 54

[:SOURce<hw>]:BB:GBAS:MSET:SRATe?

Queries the used sample rate.

Return values: 
<SRate> float

Range: 10.49E3  to  10.51E3
Increment: 1E-3
*RST: 10.5E3

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Usage: Query only

Manual operation: See "Sample Rate Variation/Sample Rate Info" on page 54

[:SOURce<hw>]:BB:GBAS:SRINfo?

Queries the used sample rate.

Return values: 
<SRInfo> string

Example: See Example"Querying the default filter, clipping and modulation
settings" on page 71.

Usage: Query only

Manual operation: See "Sample Rate Variation/Sample Rate Info" on page 54

6.7  Trigger commands

[:SOURce<hw>]:BB:GBAS[:TRIGger]:SEQuence.............................................................. 114
[:SOURce<hw>]:BB:GBAS:TRIGger:SOURce...................................................................114
[:SOURce<hw>]:BB:GBAS:TRIGger:RMODe?.................................................................. 115
[:SOURce<hw>]:BB:GBAS:TRIGger:TIME:DATE...............................................................115
[:SOURce<hw>]:BB:GBAS:TRIGger:TIME:TIME............................................................... 115
[:SOURce<hw>]:BB:GBAS:TRIGger:TIME[:STATe]............................................................ 116
[:SOURce<hw>]:BB:GBAS:TRIGger:SLENgth...................................................................116
[:SOURce<hw>]:BB:GBAS:TRIGger:SLUNit......................................................................117
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[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute.......................................................... 117
[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute.................................................................. 117
[:SOURce<hw>]:BB:GBAS:TRIGger:EXTernal:SYNChronize:OUTPut..................................117
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:DELay............................................... 117
[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:INHibit............................................... 118
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:DELay................................................... 118
[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:INHibit................................................... 118

[:SOURce<hw>]:BB:GBAS[:TRIGger]:SEQuence <Sequence>

Selects the trigger mode.

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

*RST: AUTO

Example: See Example"Adjusting clock, marker and trigger settings"
on page 71.

Manual operation: See "Mode" on page 57

[:SOURce<hw>]:BB:GBAS:TRIGger:SOURce <Source>

Selects the trigger signal source and determines the way the triggering is executed.
Provided are:
● Internal triggering by a command (INTernal)
● External trigger signal via one of the local or global connectors

– EGT1|EGT2: External global trigger
– EGC1|EGC2: External global clock
– ELTRigger: External local trigger
– ELCLock: External local clock

● Internal triggering by a signal from the other basebands (INTA|INTB)
● OBASeband|BEXTernal|EXTernal: Setting only

Provided only for backward compatibility with other Rohde & Schwarz signal gener-
ators.
The R&S SMW accepts these values and maps them automatically as follows:
EXTernal = EGT1, BEXTernal = EGT2, OBASeband = INTA or INTB
(depending on the current baseband)

Parameters:
<Source> INTernal | EGT1 | EXTernal | EGC1 | INTB | OBASeband |

ELTRigger | EGT2 | EGC2 | INTA | ELCLock | BEXTernal
*RST: INTernal

Example: See Example"Adjusting clock, marker and trigger settings"
on page 71.

Manual operation: See "Source" on page 58

Trigger commands
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[:SOURce<hw>]:BB:GBAS:TRIGger:RMODe?

Queries the status of signal generation.

Return values: 
<RMode> STOP | RUN

*RST: STOP

Example: :SOURce1:BB:GBAS:TRIGger:SOURce EXTernal
:SOURce1:BB:GBAS:TRIGger:SEQuence ARETrigger
:SOURce1:BB:GBAS:TRIGger:RMODe?
// Response: RUN

Usage: Query only

Manual operation: See "Running/Stopped" on page 58

[:SOURce<hw>]:BB:GBAS:TRIGger:TIME:DATE <Year>, <Month>, <Day>

Sets the date for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this date via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<Year> integer

Range: 1980  to  9999

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMW user manual.

Manual operation: See "Trigger Time" on page 58

[:SOURce<hw>]:BB:GBAS:TRIGger:TIME:TIME <Hour>, <Minute>, <Second>

Sets the time for a time-based trigger signal. For trigger modes single or armed auto,
you can activate triggering at this time via the following command:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:STATe
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Trigger commands
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Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> integer
Range: 0  to  59

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMW user manual.

Manual operation: See "Trigger Time" on page 58

[:SOURce<hw>]:BB:GBAS:TRIGger:TIME[:STATe] <State>

Activates time-based triggering with a fixed time reference. If activated, the R&S SMW
triggers signal generation when its operating system time matches a specified time.

Specify the trigger date and trigger time with the following commands:

SOURce<hw>:BB:<DigStd>:TRIGger:TIME:DATE
SOURce<hw>:BB:<DigStd>:TRIGger:TIME:TIME
<DigStd> is the mnemonic for the digital standard, for example, ARB. Time-based trig-
gering behaves analogously for all digital standards that support this feature.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See example "Configure a time-based trigger signal" in the sub-
chapter "Trigger Commands" of the chapter "SOURce:BB:ARB
subsystem" in the R&S SMW user manual.

Manual operation: See "Time Based Trigger" on page 57

[:SOURce<hw>]:BB:GBAS:TRIGger:SLENgth <Slength>

Defines the signal sequence length.

Parameters:
<Slength> integer

Range: 1  to  4294967295
*RST: 5250

Example: :SOURce1:BB:GBAS:TRIGger:SLUNit SEQuence
:SOURce1:BB:GBAS:TRIGger:SLENgth 10

Manual operation: See "Signal Duration" on page 57

Trigger commands
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[:SOURce<hw>]:BB:GBAS:TRIGger:SLUNit <Slunit>

Sets the units the trigger sequence length is expressed in.

Parameters:
<Slunit> SEQuence | SAMPle

*RST: SEQuence

Example: :SOURce1:BB:GBAS:TRIGger:SLUNit SEQuence
Manual operation: See "Signal Duration Unit" on page 57

[:SOURce<hw>]:BB:GBAS:TRIGger:ARM:EXECute

Stops the signal generation until subsequent trigger event occurs.

Example: See Example"Adjusting clock, marker and trigger settings"
on page 71.

Usage: Event

Manual operation: See "Arm" on page 58

[:SOURce<hw>]:BB:GBAS:TRIGger:EXECute

Executes trigger manually.

You can execute the trigger manually only if you select an internal trigger source and a
trigger mode other than "Auto".

Example: See Example"Adjusting clock, marker and trigger settings"
on page 71.

Usage: Event

Manual operation: See "Execute Trigger" on page 58

[:SOURce<hw>]:BB:GBAS:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

Enables/disables output of the signal synchronous to the external trigger event.

Parameters:
<Output> 1 | ON | 0 | OFF

*RST: 1

Example: SOURce1:BB:GBAS:TRIGger:EXTernal:SYNChronize:
OUTPut ON

Manual operation: See "Sync. Output to External Trigger/Sync. Output to Trigger"
on page 59

[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:DELay <Delay>

Specifies the trigger delay for external triggering.

Trigger commands
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Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01
*RST: 0

Example: :SOURce1:BB:GBAS:TRIGger:EXTernal1:DELay 10
Manual operation: See "External Delay/Trigger Delay" on page 60

[:SOURce<hw>]:BB:GBAS:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

Specifies the number of symbols by which a restart is to be inhibited following a trigger
event.

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Example: :SOURce1:BB:GBAS:TRIGger:EXTernal1:INHibit 100
Manual operation: See "External Inhibit/Trigger Inhibit" on page 60

[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:DELay <Delay>

Parameters:
<Delay> float

Range: 0  to  65535
Increment: 0.01
*RST: 0

Manual operation: See "External Delay/Trigger Delay" on page 60

[:SOURce<hw>]:BB:GBAS:TRIGger:OBASeband:INHibit <Inhibit>

Parameters:
<Inhibit> integer

Range: 0  to  67108863
*RST: 0

Manual operation: See "External Inhibit/Trigger Inhibit" on page 60

6.8  Marker commands

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay.................................................. 119
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:MODE.................................................. 119
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:ONTime................................................ 119
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:OFFTime.............................................. 119
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[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PATTern................................................119
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:DIVider......................................120
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:FREQuency?............................. 120

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:DELay <Delay>

Sets the marker delay.

Parameters:
<Delay> float

Range: 0  to  16777215
Increment: 0.001
*RST: 0

Example: :SOURce1:BB:GBAS:TRIGger:OUTPut1:DELay 1600
Sets the a marker delay of 1600 samples.

Manual operation: See "Delay" on page 62

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:MODE <Mode>

Defines the signal for the selected marker output.

Parameters:
<Mode> PULSe | RESTart | PATTern | RATio | TRIGger | PPS

*RST: PPS

Example: See Example"Adjusting clock, marker and trigger settings"
on page 71.

Manual operation: See "Mode" on page 61

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:OFFTime <OffTime>
Sets the number of symbols in a period (On time + Off time) for marker RATio
Parameters:
<OffTime> integer

Range: 1  to  16777215
*RST: 1

Example: See Example"Adjusting clock, marker and trigger settings"
on page 71.

Manual operation: See "Mode" on page 61

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PATTern <Pattern>, <BitCount>

Defines the bit pattern used to generate the marker signal PATTern.

Marker commands
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Parameters:
<Pattern> numeric

*RST: #H2

<BitCount> integer
Range: 1  to  64
*RST: 2

Example: :SOURce1:BB:GBAS:TRIGger:OUTPut1:MODE PATTern
:SOURce1:BB:GBAS:TRIGger:OUTPut1:PATTern
#H5670,15

Manual operation: See "Mode" on page 61

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

Sets the divider for Pulse marker mode (PULSe).

Parameters:
<Divider> integer

Range: 2  to  1024
*RST: 2

Example: :SOURce1:BB:GBAS:MSET:SRATe?
Response: 10500
:SOURce1:BB:GBAS:TRIGger:OUTPut2:MODE PULSe
:SOURce1:BB:GBAS:TRIGger:OUTPut2:PULSe:DIVider
4
:SOURce1:BB:GBAS:TRIGger:OUTPut2:PULSe:
FREQuency?
Response: 2625
2625 = 10500/4

Manual operation: See "Mode" on page 61

[:SOURce<hw>]:BB:GBAS:TRIGger:OUTPut<ch>:PULSe:FREQuency?

Queries the pulse frequency of the pulsed marker signal PULSe.

Return values: 
<Frequency> float

Range: 2  to  1024
Increment: 1E-3
*RST: 2

Usage: Query only

Manual operation: See "Mode" on page 61

Marker commands
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6.9  Clock commands

[:SOURce<hw>]:BB:GBAS:CLOCk:SOURce.....................................................................121
[:SOURce<hw>]:BB:GBAS:CLOCk:MODE........................................................................121

[:SOURce<hw>]:BB:GBAS:CLOCk:SOURce <Source>

Selects the clock source.
● INTernal: Internal clock reference.

Parameters:
<Source> INTernal

*RST: INTernal

Example: See Example"Adjusting clock, marker and trigger settings"
on page 71.

Manual operation: See "Clock Source" on page 63

[:SOURce<hw>]:BB:GBAS:CLOCk:MODE <Mode>

Sets the type of the external clock.

Parameters:
<Mode> MSAMple | SAMPle

*RST: SAMPle

Manual operation: See "Clock Mode" on page 64

Clock commands
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Annex
A  Supported file formats

The R&S SMW supports the following file formats:
● Waypoint files, see Chapter A.1, "Waypoint file format", on page 122.
● Files with GBAS differential data, see Chapter A.2, "GBAS differential file format",

on page 122.
● Files with SCAT-I differential data, see Chapter A.3, "SCAT-I differential file format",

on page 125.

These files use predefined file extensions and file structure.

A.1  Waypoint file format

The waypoint files use the file extension *.txt. The file format is a list of coordinates
(longitude, latitude, altitude) and a respective resolution in milliseconds (see Exam-
ple"Contents of the predefined waypoint file Braunschweig.txt" on page 122).

Example: Contents of the predefined waypoint file Braunschweig.txt
The resolution command at the beginning of the format specifies the sampling interval
to be used for the WGS84 geodetic coordinates list. The resolution gives the time (in
ms) between two consecutive waypoints.

RESOLUTION: 10000
10.48270840370976,52.32054084253119,1200
10.48782531447518,52.32057768227161,1100
10.49064540739393,52.32038679250167,1000
10.49541991083499,52.32019512664971,900
10.50027587576012,52.32000536916035,800
10.50535314978533,52.3200431506525,700
10.50926768002483,52.32002989881414,600
10.51213496693413,52.31984142364868,500
10.51596247360969,52.31963813345246,400
10.52023872584375,52.31964325051492,300
10.52435479286515,52.31930292486343,200
10.52746875803649,52.31913528562811,100

A.2  GBAS differential file format

The GBAS differential files are proprietary files with file extension *.rs_gbas. The file
contains the required information for message type 1, as defined in the GBAS specifi-
cation RTCA DO-246D.

GBAS differential file format
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Example: Predefined GBAS differential file Correction1.rs_gbas
The R&S SMW expects GBAS differential data structured and tagged as in the exam-
ple of the file format Example"Predefined GBAS differential file Correction1.rs_gbas"
on page 123 below.
All parameters and tags within the file format are mandatory.

<reference1>
    <general>
        <property refcoord="11.5833,48.15,110"/>
    </general>
    <dgnssrecord>
        <property modifiedzcount="215.1"/>    
        <property ephemerisdecorrelation1="0x00">    
        <property ephemerisdecorrelation11="0x00">    
        <property sourceavailabilityduration="0xFF">    
        <property measurementtype="0"/>    
        <property ephemeriscrc="0xECF0"/>
        <dgnssvector crc="" data="G1,4,311.49,-1.20"/>
        <dgnssvector crc="" data="G3,16,81.6,3.41"/>
        <dgnssvector crc="" data="G4,110,65,-1.1"/>
        <dgnssvector crc="" data="G10,21,6.31,-0.51"/>
        <dgnssvector crc="" data="R6,61,5.85,-0.41"/>
        <dgnssvector crc="" data="S125,126,212.15,9.41"/>
    </dgnssrecord>
    <dgnssrecord>
        <property modifiedzcount="225.1"/>    
        <property ephemerisdecorrelation1="0x00">    
        <property ephemerisdecorrelation11="0x00">    
        <property sourceavailabilityduration="0xFF">    
        <property measurementtype="0"/>    
        <property ephemeriscrc="0xEFF0"/>    
        <dgnssvector crc="" data="G1,4,311.49,-1.20"/>
        <dgnssvector crc="" data="G3,16,81.6,3.41"/>
        <dgnssvector crc="" data="G4,110,65,-1.1"/>
        <dgnssvector crc="" data="G10,21,6.31,-0.51"/>
        <dgnssvector crc="" data="R6,61,5.85,-0.41"/>
        <dgnssvector crc="" data="S125,126,212.15,9.41"/>
    </dgnssrecord>
    <dgnssrecord>
        <property modifiedzcount="235.1"/>    
        <property ephemerisdecorrelation1="0x00">    
        <property ephemerisdecorrelation11="0x00">    
        <property sourceavailabilityduration="0xFF">    
        <property measurementtype="0"/>    
        <property ephemeriscrc="0xBCF0"/>    
        <dgnssvector crc="" data="G1,4,311.49,-1.20"/>
        <dgnssvector crc="" data="G3,16,81.6,3.41"/>
        <dgnssvector crc="" data="G4,110,65,-1.1"/>
        <dgnssvector crc="" data="G10,21,6.31,-0.51"/>

GBAS differential file format
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        <dgnssvector crc="" data="R6,61,5.85,-0.41"/>
        <dgnssvector crc="" data="S125,126,212.15,9.41"/>
    </dgnssrecord>    
</reference1>

The Format of *.rs_gbas file describes the used tags and parameters. The differential
GNSS vector <dgnssvector> supports message type 1 and message type 11
<data>.

Table A-1: Format of *.rs_gbas file

Container Tag name Parameter Description

<reference1>    

<general>    

 <property> <refcoord> Longitude, latitude and altitude of the reference point

<dgnssrecord>   One <dgnssrecord> per measurement

 <property> <modifiedzcount> Modified z-count for one or more records

  <ephemerisdecorrelation1> Ephemeris decorrelation for message type 1

Characterizes the impact of residual ephemeris errors due to spa-
tial decorrelation. If the parameter is omitted, the default value "0"
is transmitted.

  <ephemerisdecorrelation11> Ephemeris decorrelation for message type 11

Characterizes the impact of residual ephemeris errors due to spa-
tial decorrelation. If the parameter is omitted, the default value "0"
is transmitted.

  <sourceavailabilityduration> Specifies the predicted duration, for that corrections for the rang-
ing source are expected to remain available, relative to the modi-
fied z-count for the first measurement block.

If the parameter is omitted, transmitted is "0xFF" to indicate that
duration information is not provided.

  <measurementtype> Measurement type

  <ephemeriscrc> Ephemeris CRC

 <dgnssvector>  One <dgnssvector> per each of the N measurement blocks:

  <crc> The CRC keyword tag is mandatory, the content can be empty:
<crc>=""

  <data> <GNSS_Standard: G for GPS, R for Glonass and S for
SBAS><SVID>,

<Issue of Data (IOD)>,

<Pseudorange Correction (PRC_100/PRC_30 for MT 1/11) in m>,

<Range Rate Correction (RRC_100/RRC_30 for MT 1/11) in
m/s>,

<Sigma_pr_gnd_100 (SPR_100)>,

<Sigma_pr_gnd_30 (SPR_30)>,

<B1>,<B2>,<B3>,<B4>

GBAS differential file format
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A.3  SCAT-I differential file format

The SCAT-I differential files are proprietary files with file extension *.rs_scat. The
file contains the required information for message type 1, as defined in the GBAS
specification RTCA DO-217.

Example: Predefined SCAT-I differential file Correction1.rs_scat
The R&S SMW expects GBAS differential data structured and tagged as in the exam-
ple of the file format Example"Predefined SCAT-I differential file Correction1.rs_scat"
on page 125 below.
All parameters and tags within the file format are in conformance with the GBAS speci-
fication RTCA DO-217.
<reference1>
    <general>
        <property refcoord="11.5833,48.15,110"></property>
    </general>
    <dgnssrecord>
        <property modifiedzcount="215.1"></property>
        <dgnssvector data="G1,4,311.49,-1.20"></dgnssvector>
        <dgnssvector data="G3,16,81.6,3.41"></dgnssvector>
        <dgnssvector data="G4,110,65,-1.1"></dgnssvector>
        <dgnssvector data="G10,21,6.31,-0.51"></dgnssvector>
    </dgnssrecord>
    <dgnssrecord>
        <property modifiedzcount="225.1"></property>
        <dgnssvector data="G1,4,311.49,-1.20"></dgnssvector>
        <dgnssvector data="G3,16,81.6,3.41"></dgnssvector>
        <dgnssvector data="G4,110,65,-1.1"></dgnssvector>
        <dgnssvector data="G10,21,6.31,-0.51"></dgnssvector>
    </dgnssrecord>
    <dgnssrecord>
        <property modifiedzcount="235.1"></property>
        <dgnssvector data="G1,4,311.49,-1.20"></dgnssvector>
        <dgnssvector data="G3,16,81.6,3.41"></dgnssvector>
        <dgnssvector data="G4,110,65,-1.1"></dgnssvector>
        <dgnssvector data="G10,21,6.31,-0.51"></dgnssvector>
    </dgnssrecord>    
</reference1>

The Format of *.rs_scat file describes the used tags and parameters.
Table A-2: Format of *.rs_scat file

Container Tag name Parameter Description

<reference1>    

<general>    

 <property> <refcoord> longitude, latitude and altitude of the reference point

<dgnssrecord>   one <dgnssrecord> per measurements

SCAT-I differential file format
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Container Tag name Parameter Description

 <property> <modifiedzcount> Modified z-count for the record (s)

 <dgnssvector>  One <dgnssvector> per each of the N measurement blocks:

  <crc> The CRC keyword tag is mandatory, the content can be empty:
<crc>=""

  <data> <GNSS_Standard: G for GPS, R for GLONASS and S for
SBAS><SVID>,

<Issue of Data (IOD)>,

<Pseudorange Correction (PRC) in (m)>,

<Range Rate Correction (RRC) in (m/s)>,

<Sigma_pr_gnd (SPR)>,<B1>,<B2>,<B3>,<B4>

SCAT-I differential file format
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Glossary: Specifications and references
R

RTCA DO-217: "Minimum Aviation System Performance Standards DGNSS Instru-
ment Approach System: Special Category 1 (SCAT-1)"

RTCA DO-246D: "GNSS-Based Precision Approach Local Area Augmentation System
(LAAS) Signal-in-Space Interface Control Document (ICD)"
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